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1 Introduction

About this chapter
This chapter contains important user information, descriptions of safety notices,
intended use of the ÄKTA™ avant instrument, and lists of associated documentation.

In this chapter

Section See page

1.1 About this manual 5

1.2 Important user information 6

1.3 Associated Documentation 8

1 Introduction
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1.1 About this manual

Purpose of this manual
The Operating Instructions provide you with the information needed to install, operate
and maintain the product in a safe way.

Scope of this manual
The Operating Instructions cover ÄKTA avant 25 and ÄKTA avant 150 instruments,
using previously created methods in UNICORN software 6.3.2 and later.

Typographical conventions
Software items are identified in the text by bold italic text.

Hardware items are identified in the text by bold text.

In electronic format, references in italics are clickable hyperlinks.

1 Introduction
1.1 About this manual
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1.2 Important user information

Read this before operating the
product

All users must read the entire Operating Instructions before installing, oper-
ating or maintaining the product.

Always keep the Operating Instructions at hand when operating the product.

Do not operate the product in any other way than described in the user documenta-
tion. If you do, you may be exposed to hazards that can lead to personal injury and you
may cause damage to the equipment.

Intended use of the product
ÄKTA avant is a liquid chromatography system intended for method and process
development in purification of biomolecules. The system can be used to screen for
optimal choice of columns, media and running parameters to purify selected proteins.

The ÄKTA avant system is intended for research use only, and shall not be used in any
clinical procedures, or for diagnostic procedures.

Prerequisites
In order to follow this manual and use the system in the manner it is intended, it is
important that:

• You have a general understanding of how the computer and Microsoft® Windows®
work.

• You understand the concepts of liquid chromatography.

• You have read and understood the Safety instructions chapter in this manual.

• A user account has been created according to the UNICORN™ Administration and
Technical Manual.

1 Introduction
1.2 Important user information
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Definitions
This user documentation contains safety notices (WARNING, CAUTION, and NOTICE)
concerning the safe use of the product. See definitions below.

WARNING

WARNING indicates a hazardous situation which, if not avoided,
could result in death or serious injury. It is important not to proceed
until all stated conditions are met and clearly understood.

CAUTION

CAUTION indicates a hazardous situation which, if not avoided,
could result in minor or moderate injury. It is important not to
proceed until all stated conditions are met and clearly understood.

NOTICE

NOTICE indicates instructions that must be followed to avoid
damage to the product or other equipment.

Notes and tips
Note: A note is used to indicate information that is important for trouble-free and

optimal use of the product.

Tip: A tip contains useful information that can improve or optimize your proce-
dures.

1 Introduction
1.2 Important user information
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1.3 Associated Documentation

Introduction
This section describes the user documentation that is delivered with ÄKTA avant.

User documentation on the CD
The user documentation listed in the table below is available in printed or PDF format.
The complete documentation is also available on the User Documentation CD.

Document Main contents

ÄKTA avant Unpacking Instruc-
tion

(29101559)

Instructions for unpacking the instrument,
and how to lift the instrument onto a bench.

ÄKTA avant Operating
Instructions

(29101556)

Instructions needed to install, operate and
maintain the system in a safe way.

ÄKTA avant User Manual

(29035184)

Instructions for handling the system. Descrip-
tions of components. Information about how
to run and maintain the system.

ÄKTA avant 25 Product
Documentation

(28991000) OR

ÄKTA avant 150 Product
Documentation (28984249)1

System specification and declaration of mate-
rial conformity.

1 The instrument is delivered with the relevant document.

UNICORN user documentation
The user documentation listed in the following table is available from the Help menu in
UNICORN or from the UNICORN Online Help and Documentation software
accessed by pressing the F1 key in any UNICORN module.

Documentation Main contents

UNICORN Help Descriptions of UNICORN dialog boxes (available
from the Help menu).

Getting started with
Evaluation

Note:

Available in UNICORN 7.0
and later.

• Video clips showing common workflows in the
Evaluation module.

• Overview of features of the Evaluation module.

1 Introduction
1.3 Associated Documentation
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Documentation Main contents

UNICORN Method Manual
1

• Overview and detailed descriptions of the method
creation features in UNICORN.

• Workflow descriptions for common operations.

UNICORN Administration
and Technical Manual 1

• Overview and detailed description of network
setup and complete software installation.

• Administration of UNICORN and the UNICORN
database.

UNICORN Evaluation
Manual 1

• Overview and detailed descriptions of the
Evaluation Classic module in UNICORN.

• Description of the evaluation algorithms used in
UNICORN.

UNICORN System Control
Manual 1

• Overview and detailed description of the system
control features in UNICORN.

• Includes general operation, system settings and
instructions on how to perform a run.

1 Current UNICORN version is added to the title of the manual.

Data files, application notes and user
documentation on the web

To order or download data files, application notes or user documentation, see the
instruction below.

Step Action

1 Go to cytiva.com/avant.

2 Click Product support.

3 Click Related Documents.

4 Select to download the chosen literature.

Additional literature
For practical tips on chromatography, refer to Handbook 29010831.

1 Introduction
1.3 Associated Documentation
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2 Safety Instructions

About this chapter
This chapter describes safety precautions, labels and symbols that are attached to the
equipment. In addition, the chapter describes emergency and recovery procedures.

Important

WARNING
Before installing, operating or maintaining the product, all
users must read and understand the entire contents of this
chapter to become aware of the hazards involved.

In this chapter

Section See page

2.1 Safety Precautions 11

2.2 Labels 21

2.3 Emergency procedures 23

2 Safety Instructions
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2.1 Safety Precautions

Introduction
ÄKTA avant is powered by mains voltage and handles materials that may be
hazardous. Before installing, operating or maintaining the system, you must be aware
of the hazards described in this manual.

Follow the instructions provided to avoid personal injuries or damage to the
product, or to other personnel and equipment in the area.

The safety precautions in this section are grouped into the following categories:

• General precautions on page 11

• Personal protection on page 13

• Flammable liquids and explosive environment on page 14

• Installing and moving on page 15

• System operation on page 17

• Maintenance on page 20

General precautions

WARNING

Risk assessment. Perform a risk assessment for any risks due to
the process or process environment. Evaluate the effects the use of
the product and the operational processes may have on the classi-
fication of the hazardous area. The process might cause the area to
increase or the zone classification to change. Implement the risk
reduction measures needed, including use of personal protective
equipment.

2 Safety Instructions
2.1 Safety Precautions
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WARNING
Always follow these General precautions to avoid injury
when using the ÄKTA avant instrument.

• Do not operate the ÄKTA avant instrument in any other way
than described in the ÄKTA avant and UNICORN manuals.

• Only properly trained personnel may operate and maintain the
product.

• Before connecting a column, read the instructions for use of the
column. To avoid exposing the column to excessive pressure,
make sure that the pressure limit is set to the specified
maximum pressure for the column.

• Do not use any accessories not supplied or recommended by
Cytiva.

• Do not use ÄKTA avant if it is not working properly, or if it has
suffered any damage, for example:

- damage to the power cord or its plug

- damage caused by dropping the equipment

- damage caused by splashing liquid onto it

NOTICE

Avoid condensation. If ÄKTA avant is kept in a cold room, cold
cabinet or similar, keep it switched on in order to avoid condensa-
tion.

2 Safety Instructions
2.1 Safety Precautions
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Personal protection

WARNING
To avoid injury when working with the ÄKTA avant system,
take the following measures for personal protection.

• Always use appropriate Personal Protective Equipment (PPE)
during operation and maintenance of this product.

• Hazardous substances and biological agents. When using
hazardous chemical and biological agents, take all suitable
protective measures, such as wearing protective clothing,
glasses and gloves resistant to the substances used. Follow
local and/or national regulations for safe operation and mainte-
nance of ÄKTA avant.

• Spread of biological agents. The operator must take all
necessary actions to avoid spreading hazardous biological
agents. The facility must comply with the national code of prac-
tice for biosafety.

• High pressure. The product operates under high pressure.
Wear protective glasses and other required Personal Protective
Equipment (PPE) at all times.

CAUTION
To avoid hazardous situations when working with the ÄKTA
avant system, take the following measures for personal
protection.

• Always use appropriate personal protective equipment when
decommissioning the equipment.

• Close doors. To minimize the risk of exposure to hazardous
chemicals and pressurized liquids, always close the foldable
door and the pump cover before starting a run.

• Cut injuries. The tubing cutter is very sharp and must be
handled with care to avoid injuries.

2 Safety Instructions
2.1 Safety Precautions
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Flammable liquids and explosive
environment

WARNING
When using flammable liquids with the ÄKTA avant system,
follow these precautions to avoid any risk of fire or explosion.

• Fire Hazard. Before starting the system, make sure that there is
no leakage.

• Explosion hazard. To avoid building up an explosive atmos-
phere when using flammable liquids, make sure that the room
ventilation meets the local requirements.

• Fraction collector. Do not fractionate flammable liquids in the
built-in fraction collector. When running RPC methods, collect
fractions through the outlet valve or the optional external Frac-
tion collector F9-R.

• RPC runs with 100% acetonitrile and system pressure
above 5 MPa (50 bar) in ÄKTA avant 25 . Always replace the
green PEEK tubing between the used system pump and the
pump pressure monitor with orange PEEK tubing, i.d. 0.5 mm,
before running RPC with 100% acetonitrile. Set the system
pressure alarm to 10 MPa (100 bar).

• RPC runs with 100% acetonitrile in ÄKTA avant 150 .
Always replace the beige PEEK tubing between the used system
pump and the pump pressure monitor before running RPC with
100% acetonitrile. Replace it with green PEEK tubing, i.d. 0.75
mm.

2 Safety Instructions
2.1 Safety Precautions
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Installing and moving

WARNING
To avoid injury when installing and moving the ÄKTA avant
system, take the following measures for personal protection.

• Move transport crates. Make sure that the lifting equipment
has the capacity to safely lift the crate weight. Make sure that
the crate is properly balanced so that it will not accidentally tip
when moved.

• Heavy object. The ÄKTA avant instrument weighs about 116
kg. Use proper lifting equipment, or use four or more persons
when moving the instrument. All lifting and moving must be
performed in accordance with local regulations.

• Moving the product horizontally. Three people are required
to move the product horizontally.

• Supply voltage. Before connecting the power cord, make sure
that the supply voltage at the wall outlet corresponds to the
marking on the instrument.

• Protective ground. The product must always be connected to
a grounded power outlet.

• Power cord. Only use power cords with approved plugs deliv-
ered or approved by Cytiva.

• Access to power switch and power cord with plug. Do not
block access to the power switch and power cord. The power
switch must always be easy to access. The power cord with plug
must always be easy to disconnect.

• Installing the computer. The computer must be installed and
used according to the instructions provided by the manufac-
turer of the computer.

2 Safety Instructions
2.1 Safety Precautions
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NOTICE
To avoid damage to the instrument when installing and
moving the ÄKTA avant system, take the following meas-
ures.

• Make sure that the waste vessels will hold all the produced
volume of the run. For ÄKTA avant 25, a suitable waste vessel
should typically have a volume of 2 to 10 liters. For ÄKTA avant
150, a waste vessel should have a volume of 40 liters.

• The maximum level of the waste vessel for the waste tubing
from the valves must be lower than 30 cm above the lab bench.

• The maximum level of the waste vessel for the waste tubing
from the fraction collector and the buffer tray must be lower
than the bench height.

• Vents on the product instrument. To ensure adequate venti-
lation, keep papers and other objects away from the vents of the
instrument.

• Disconnect power. To prevent equipment damage, always
disconnect the power from the product before an instrument
module is removed or installed, or a cable is connected or
disconnected.

• Misuse of UniNet-9 connectors. The UniNet-9 connectors at
the rear panel should not be mistaken for Firewire connectors.
Do not connect any external equipment to the UniNet-9
connectors other than instrument modules designed for the
product. See ÄKTA avant User Manual . Do not disconnect or
move the UniNet-9 bus cable.

• Any computer used with the equipment must comply with
EN/IEC 60950-1, and be installed and used according to the
manufacturer's instructions.

2 Safety Instructions
2.1 Safety Precautions
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System operation

WARNING
To avoid personal injury when operating the ÄKTA avant
system, follow these instructions.

• Rotating the instrument. Make sure that there is always at
least 20 cm of free space around the ÄKTA avant instrument to
allow for sufficient ventilation and rotation on the swivel foot.
When rotating the instrument, take care not to stretch or
squeeze tubing or cables. A disconnected cable may cause
power interruption or network interruption. Stretched tubing
may cause bottles to fall, resulting in liquid spillage and shat-
tered glass. Squeezed tubing may cause increase in pressure, or
block liquid flow. To avoid the risk of knocking over bottles,
always place bottles on the buffer tray, and close the doors
before rotating the instrument.

• Fasten bottles and cassettes. Always fasten bottles and
cassettes to the rails at the front and side panel. Use appro-
priate holders for bottles. Shattered glass from falling bottles
may cause injury. Spilled liquid may cause fire hazard and
personal injury.

• Electrical shock hazard after spillage. If there is a risk that
large volumes of spilled liquid may penetrate the casing of the
instrument, immediately switch off the instrument, disconnect
the power cord, and contact an authorized service engineer.

• Moving parts in fraction collector. Do not open the built-in
fraction collector door when the instrument is running.

• Using a Superloop . After loading a Superloop, always plug the
Syr port on the injection valve with a stop plug. With a Superloop
connected to the valve, an over-pressure may be created during
injection.

• Overpressure. Never block the outlet tubing with, for instance,
stop plugs, since this will create overpressure and might result
in injury.

• Hazardous chemicals during run. When using hazardous
chemicals, run System CIP and Column CIP to flush the entire
system tubing with distilled water, before service and mainte-
nance.

• Hazardous biological agents during run. When using
hazardous biological agents, run System CIP and Column CIP
to flush the entire pump with bacteriostatic solution (e.g. 1M
NaOH) followed by a neutral buffer and finally distilled water,
before service and maintenance.

2 Safety Instructions
2.1 Safety Precautions
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CAUTION
To avoid hazardous situations when operating the ÄKTA
avant system, follow these instructions.

• Risk of breaking test vials. Do not use excessive force to press
vials of wrong dimensions into the fraction collector cassettes.
Glass vials may break and cause injuries.

• Hazardous chemicals in UV flow cell. Make sure that the
entire flow cell has been flushed thoroughly with bacteriostatic
solution, for example NaOH, and distilled water, before service
and maintenance.

• pH-electrode. Handle the pH-electrode with care. The glass tip
may break and cause injury.

• Do not fasten bottles with a volume of more than 1 liter in the
front panel rails.

• Max. weight on buffer tray. Do not place containers with a
volume of more than 10 liters each on the buffer tray. The total
allowed weight on the buffer tray is 40 kg.

2 Safety Instructions
2.1 Safety Precautions
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NOTICE
To avoid damage to the ÄKTA avant instrument or other
equipment when operating the instrument, follow these
instructions.

• Keep UV flow cell clean. Do not allow solutions containing
dissolved salts, proteins or other solid solutes to dry out in the
flow cell. Do not allow particles to enter the flow cell, as damage
to the flow cell may occur.

• Glass tube splinter. Make sure to set the sample pressure
below the maximum pressure of the Superloop before executing
a flow in the Manual instructions dialog box when the Super-
loop is connected.

• Avoid condensation. If ÄKTA avant is kept in a cold room, cold
cabinet or similar, keep it switched on in order to avoid conden-
sation.

• Avoid overheating. If ÄKTA avant is kept in a cold cabinet and
the cold cabinet is switched off, make sure to switch off ÄKTA
avant and keep the cold cabinet open to avoid overheating.

• Place the computer in room temperature. If the ÄKTA avant
instrument is placed in a cold room, use a cold room compatible
computer or place the computer outside the cold room and use
the Ethernet cable delivered with the instrument to connect to
the computer.

• UV and conductivity flow cells on the high pressure side.
When placing UV and/or conductivity flow cells on the high pres-
sure side of the column, the UV flow cell has a maximum pres-
sure limit of 2 MPa (20 bar) and the conductivity flow cell has a
maximum pressure limit of 5 MPa (50 bar).

2 Safety Instructions
2.1 Safety Precautions
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Maintenance

WARNING
To avoid personal injury when performing maintenance on
the ÄKTA avant instrument, follow these instructions.

• Electrical shock hazard. All repairs should be done by service
personnel authorized by Cytiva. Do not open any covers or
replace parts unless specifically stated in the user documenta-
tion.

• Disconnect power. Always disconnect power from the instru-
ment before replacing any component on the instrument,
unless stated otherwise in the user documentation.

• Corrosive chemicals during maintenance. If the system or
column is cleaned with a strong base or acid, flush with water
afterwards and wash with a weak neutral buffer solution in the
last step or phase.

NOTICE
To avoid damage to the ÄKTA avant instrument or other
equipment when performing maintenance on the ÄKTA
avant instrument, follow these instructions.

• Cleaning. Keep the exterior of the instrument dry and clean.
Wipe regularly with a soft damp tissue and, if necessary, a mild
cleaning agent. Let the instrument dry completely before use.

• Advanced maintenance. Read the instruction carefully before
disassembly of the pump head.

2 Safety Instructions
2.1 Safety Precautions
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2.2 Labels

Introduction
This section describes the information on the system label and other safety or regula-
tory labels that are attached to the product.

Labels on the ÄKTA avant instrument
The following illustration shows the labels that are attached to the ÄKTA avant instru-
ment.

2 Safety Instructions
2.2 Labels
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System label
The system label is located on the back of the equipment. The system label identifies
the equipment and shows electrical data, regulatory compliance, and warning
symbols.

Description of symbols on the labels
The following symbols and text may be present on the system label:

Label Meaning

Warning!

Fraction collector. Do not fractionate flammable liquids in
the built-in fraction collector. When running RPC methods,
collect fractions through the outlet valve or the optional
external Fraction collector F9-R.

Warning! Read the Operating Instruction before using the
system.

Electrical shock hazard. All repairs should be done by
service personnel authorized by Cytiva. Do not open any
covers or replace parts unless specifically stated in the user
documentation.

Supply voltage. Before connecting the power cord, make
sure that the supply voltage at the wall outlet corresponds to
the marking on the instrument.

Voltage

Frequency

Max. Power

Electrical requirements:

• Mains voltage (VAC) or other input voltage (AC or DC)

• Frequency (Hz)

• Max. power (VA)

Protection Class Degree of protection provided by the enclosure.

Mfg. Year Year (YYYY) and month (MM) of manufacture

2 Safety Instructions
2.2 Labels

22  ÄKTA avant Operating Instructions 29101556 AC



2.3 Emergency procedures

Introduction
This section describes how to perform an emergency shutdown of the ÄKTA avant
instrument, including connected equipment. This section also describes the results in
the event of power failure or network interruption.

Emergency shutdown
In an emergency situation, stop the run by either pausing the run or switching off the
instrument as described in the following table:

If you want
to...

then...

pause the run • Press the Pause button on the instrument display. This will
stop all pumps in the instrument.

or

• To pause the run from UNICORN, click the Pause button in the
System Control module:

Result: All pumps in the instrument are stopped.

switch off the
instrument

• Push the Power switch to the O position,

or

• disconnect the power cord from the wall socket.

Result: The run is interrupted immediately.

Note:

The sample and data may be lost as a result of switching off the
power.

2 Safety Instructions
2.3 Emergency procedures
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Power failure
The result of a power failure depends on which unit is affected.

Power failure to... will result in...

ÄKTA avant instrument • The run is interrupted immediately

• Data collected up to approx. 5 seconds before
the power failure is available in UNICORN.

Computer • The UNICORN computer shuts down

• The instrument display shows status Not
connected

• The run is interrupted immediately

• Data generated up to 10 seconds before the
power failure can be recovered

Note:

The UNICORN client may lose connection to
the instrument during a temporary overload of
the processor and display an error message.
This may appear as a computer failure. The run
continues and you can restart the UNICORN
client to regain control. No data will be lost.

Uninterruptible power supply (UPS)
A UPS can prevent data loss during a power failure, and allow time for a controlled shut-
down of ÄKTA avant.

For UPS power requirements, see the system specifications in this manual. Remember
to also take into account the specifications for the computer and monitor. Refer to the
manufacturers' documentation.

Note: If using a UPS, the ÄKTA avant instrument, the computer and the monitor
must be connected to the UPS.

Restart the instrument after
emergency shutdown or power
failure

Follow the instructions to restart the instrument after an emergency shutdown or
power failure.

2 Safety Instructions
2.3 Emergency procedures
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Step Action

1 Make sure that the condition that caused the emergency shutdown or
power failure is corrected.

2 If the instrument was switched off, press the Power switch on the instru-
ment.

Result:

The instrument should start and the Instrument display should show Not
connected.

3 Turn on the computer and monitor.

4 Start UNICORN and connect to the system.

See instructions in Section 4.4 Start UNICORN and connect to system, on
page 67.

2 Safety Instructions
2.3 Emergency procedures
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3 System description

About this chapter
This chapter gives an overview of the ÄKTA avant instrument, software and accesso-
ries.

In this chapter

Section See page

3.1 ÄKTA avant instrument overview 27

3.2 UNICORN software 36

Illustration of the system
The following illustration shows the ÄKTA avant instrument with UNICORN software
installed on a computer.

3 System description
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3.1 ÄKTA avant instrument overview

Introduction
This section shows an overview of the ÄKTA avant instrument. Technical details about
the instrument and the individual modules are found in ÄKTA avant User Manual.

Exterior design
The ÄKTA avant instrument has a modular design, with all the liquid handling modules
placed on the exterior of the instrument. Buffer vessels are placed on the buffer tray on
top of the instrument. An instrument display is located on the front. From this side the
built-in fraction collector is handled, as well as the sample. The remaining modules are
placed on the right-hand side of the instrument. This side can be covered by a foldable
door and a pump cover. By rotating the instrument using the swivel foot any side is
easily accessed.

Operating ranges
The following table shows some of the operational limits of ÄKTA avant 25 and ÄKTA
avant 150

Parameter Limits

ÄKTA avant 25 ÄKTA avant 150

Flow rate 0.001 to 25 ml/min

Note:

When running the
Column packing flow
instruction, the
maximum flow rate is 50
ml/min.

0.01 to 150 ml/min

Note:

When running the
Column packing flow
instruction, the
maximum flow rate is
300 ml/min.

Max. operating pressure 20 MPa (200 bar) 5 MPa (50 bar)

UV monitor wavelength 190 to 700 nm 190 to 700 nm

3 System description
3.1  ÄKTA avant instrument overview
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Illustration of the main parts of the
instrument

The following illustration shows the location of the main parts of the instrument.

Part Function Part Function

1 Fraction collector 2 Buffer tray

3 Instrument display 4 Wet side

5 Foldable door 6 Pump cover

7 Holder rails 8 Swivel foot lock/unlock knob

9 Swivel foot 10 Swing out toolbox

11 Power switch

Illustration of the wet side modules of
the instrument

The following illustration shows the modules of the wet side of the instrument.

3 System description
3.1  ÄKTA avant instrument overview
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Part Function Part Function

1 Injection valve 2 Flow restrictor

3 pH valve 4 Column valve

5 UV monitor 6 Conductivity monitor

7 Inlet valve B 8 Quaternary valve

9 System pump B 10 Pressure monitor of system
pumps

11 System pump flow restrictor 12 Inlet valve A

13 System pump A 14 Mixer

15 Sample pump flow restrictor 16 Pressure monitor of sample
pump

17 Sample pump 18 Pump rinsing solution tube

19 Sample inlet valve 20 Outlet valve

21 Holder rails

Available modules
The ÄKTA avant instrument is always delivered with the standard modules installed,
but one or more optional modules may be added to the flow path.

The following tables contains information on the standard modules and the optional
modules of the ÄKTA avant 25 and ÄKTA avant 150 instruments. The sections that
follows contain descriptions of the modules.
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Note: The valves for ÄKTA avant 25 and ÄKTA avant 150 are compatible with both
systems but for the best performance the specific valve type should be used.
The narrow channels in the valves for ÄKTA avant 25 will give too high back
pressure if used above 50 ml/min. The larger volumes in the “H” valves for
ÄKTA avant 150 may decrease resolution and increase peak broadening if
used in ÄKTA avant 25.

Standard modules

Module Label in

ÄKTA avant 25 ÄKTA avant 150

System pump A P9 A P9H A

System pump B P9 B P9H B

Sample pump P9-S P9H S

Pressure monitor R9 R9

Mixer M9 M9

Injection valve V9-Inj V9H-Inj

Quarternary valve Q9 Q9

Inlet valve A V9-IA V9H-IA

Inlet valve B V9-IB V9H-IB

Sample inlet valve V9-IS V9H-IS

Column valve V9-C V9H-C

pH valve V9-pH V9H-pH

Outlet valve V9-O V9H-O

UV monitor U9-M U9-M

Conductivity monitor C9 C9

Built-in fraction collector NA NA

Optional modules

Module Label in

ÄKTA avant 25 ÄKTA avant 150

Second Inlet valve A V9-A2 V9H-A2

Second Inlet valve B V9-B2 V9H-B2
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Module Label in

ÄKTA avant 25 ÄKTA avant 150

Extra Inlet valve X1 V9-IX V9H-IX

Extra Inlet valve X2 V9-IX V9H-IX

Second Sample inlet
valve

V9-S2 V9H-S2

Versatile valve V9-V V9H-V

Loop valve V9-L V9H-L

Second Column valve V9-C2 V9H-C2

Second Outlet valve V9-O2 V9H-O2

Third Outlet valve V9-O3 V9H-O3

External air sensor L9-1.5 L9-1.5 L9-1.5

External air sensor L9-1.2 L9-1.2 L9-1.2

I/O-box E9 E9

Second UV monitor U9-L U9-L

Second Conductivity
monitor

C9 C9

Second Fraction
collector

F9-R F9-R

Description of standard modules
The following modules are installed in the instrument when delivered.

Module Description

System pump A P9 A or P9H A A high precision pump, which delivers buffer in
purification runs.

System pump B P9 B or P9H B A high precision pump, which delivers buffer in
purification runs.

Sample pump P9-S or P9H S A high precision pump which delivers sample or
buffer in purification runs.

Pressure monitor R9 Pressure monitor which reads the system pres-
sure after System Pump A and System Pump B.
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Module Description

Pump flow restrictor Prevents the system from siphoning when the
flow path after the pump is open. Gives a small
back pressure to the pump in extreme low pres-
sure applications.

Mixer M9 Mixes the buffers delivered from the system
pumps to a homogeneous buffer composition.

Three mixer chambers are available for ÄKTA
avant 25. Available volumes are: 0.6 ml, 1.4 ml
(mounted at delivery) and 5 ml.

Three mixer chambers are available for ÄKTA
avant 150. Available volumes are: 1.4 ml, 5 ml
(mounted at delivery), and 15 ml.

CAUTION

Risk of explosion. Do not
use Mixer chamber 15 ml
with an ÄKTA avant 25
system configuration. The
maximum pressure for
Mixer chamber 15 ml is 5
MPa (50 bar).

Inlet valve A V9-IA or V9H-IA Inlet valve for System Pump A with seven inlet
ports and integrated air sensor.

Inlet valve B V9-IB or V9H-IB Inlet valve for System Pump B with seven inlet
ports and integrated air sensor.

Quaternary valve Q9 Valve which allows automatic mixing of four
different solutions.

Sample inlet valve V9-IS or
V9H-IS

Inlet valve for sample solution, with eight inlet
ports (seven sample inlets and one buffer inlet)
and integrated air sensor.

Injection valve V9-Inj or V9H-
Inj

Valve which directs sample onto the column.

Column valve V9-C or V9H-C Column valve which connects up to five columns
to the instrument, and directs the flow to one
column at a time. The column valve features two
integrated pressure sensors.

Allows the user to choose flow direction through
the column, or to bypass the column.
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Module Description

pH valve V9-pH or V9H-pH Valve which enables the pH electrode to be
included in the flow path or by-passed during a
run. The pH electrode may be calibrated when
installed in the pH Valve. It also enables the flow
restrictor to be included in the flow path (default
position) or by-passed during a run.

Outlet valve V9-O or V9H-O Valve which directs the flow to the fraction
collector, any of the ten outlet ports or waste.

UV monitor U9-M Monitor which measures the UV/Vis absorbance
at up to three wavelengths simultaneously in the
range 190 to 700 nm.

Conductivity monitor C9 Monitor which continuously measures the
conductivity of buffers and sample solutions.

Built-in fraction collector Built-in fraction collector. A cooling function
protects the fractions from heat degradation.

Core modules
Core modules need to be installed for the system to run. They are mandatory in the
software.

All standard modules except the built-in fraction collector are considered core
modules.

Description of optional modules
The following modules may be added to the flow path.

Module Description

Second Inlet valve A V9-
A2 or V9H-A2

Second inlet valves for System pump A, to extend the
number of inlets up to 14.

Second Inlet valve B V9-
B2 or V9H-B2

Second inlet valves for System pump B, to extend the
number of inlets up to 14.

Inlet valve X1 and Inlet
valve X2 V9-IX or V9H-IX

Inlet valve with eight inlet ports. No integrated air
sensor.

Second Sample inlet
valve V9-S2 or V9H-S2

Second inlet valve for Sample pump to extend the
number of sample inlets up to 14.

Versatile valve V9-V or
V9H-V

A 4-port, 4-position valve, which can be used to
customize the flow path.
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Module Description

Loop valve V9-L or V9H-
L

Valve which enables automatic sample application
from up to five sample loops, or to collect intermediate
fractions in automated two-step purification.

Second Column valve
V9-C2 or V9H-C2

Valve which connects five additional columns to the
instrument, extending the number of columns up to
10. The valve allows the user to choose flow direction
through the column, or to by-pass the column.

Second Outlet valve V9-
O2 or V9H-O2

Valve which adds 12 outlet ports to the system, giving
a total of 21 outlets.

Third Outlet valve V9-O3
or V9H-O3

Valve which adds 12 outlet ports to the system, giving
a total of 32 outlets

External air sensor
L9-1.5 or L9-1.2

Sensor which prevents air from being introduced into
the flow path.

I/O-box E9 Module which receives analog or digital signals from,
or transfers analog or digital signals to, external equip-
ment that has been incorporated in the system.

Second UV monitor U9-L Monitor which measures the UV absorbance at a fixed
wavelength of 280 nm.

Second Conductivity
monitor C9

Monitor which measures the conductivity of buffers
and sample solutions.

Second Fraction
collector F9-R

Round fraction collector that can collect up to 175
fractions.

Illustration of the instrument display
The following illustration shows the instrument display with the system state Ready
showing.
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Instrument display indicators and
buttons

The instrument display is a touchscreen that shows the current system status. The
instrument display includes the following indicators and buttons

Indicator/Button Description

Indicates if the Instrument display buttons are unlocked
or locked. The buttons can be locked from UNICORN
System Control.

Pauses the run and stops all pumps.

Resumes instrument operation from the following
states:

• Wash

• Pause

• Hold
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3.2 UNICORN software

Introduction
This section gives an overview of the UNICORN software. It also describes the System
Control module.

To learn more about System Control and the other three modules Administration,
Method Editor and Evaluation, see the UNICORN documentation package.

In this section

Section See page

3.2.1 UNICORN software overview 37

3.2.2 The System Control module 38
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3.2.1 UNICORN software overview

Introduction
This section gives a brief overview of the UNICORN software: a complete package for
control, supervision and evaluation of chromatography instruments and purification
runs.

From hereon, UNICORN refers to compatible versions of the software. The examples
given in this manual are from UNICORN 6.4.

UNICORN modules overview
UNICORN consists of four modules: Administration, Method Editor, System
Control and Evaluation. The main functions of each module are described in the
following table.

Module Main functions

Administration Perform user and system setup, system log and data-
base administration.

Method Editor Create and edit methods using one or a combination of:

• Predefined methods with built-in application support

• Drag-and-drop function to build methods with rele-
vant steps

• Line-by-line text editing

The interface provides easy viewing and editing of run
properties.

System Control Start, monitor and control runs. The current flow path is
illustrated in the Process Picture, which allows manual
interactions with the system and provides feedback on
run parameters.

Evaluation Open results, evaluate runs and create reports.

• The default Evaluation module includes a user inter-
face optimized for workflows like quick evaluation,
compare results and work with peaks and fractions.

• To perform operations like Design of Experiments,
users can easily switch to Evaluation Classic.

When working with the modules Administration, Method Editor, System Control
and Evaluation Classic it is possible to access descriptions of the active window by
pressing the F1 key. This can be especially helpful when editing methods
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3.2.2 The System Control module

Introduction
The System Control module is used to start, view, and control a manual or method
run.

System Control panes
As seen in the following illustration, three panes are shown in the System Control
module by default.

The Run Data pane (1) presents current data in numerical values.

The Chromatogram pane (2) illustrates data as curves during the entire run.

The current flow path is illustrated in the Process Picture (3), which allows manual
interactions with the system and provides feedback on run parameters.

1

2

3

Note: On the View menu, click Run Log to open the Run Log pane which presents
all registered actions.

System Control toolbar buttons
The following table shows the System Control toolbar buttons that are referred to in
this manual.

3 System description
3.2  UNICORN software

3.2.2 The System Control module

38  ÄKTA avant Operating Instructions 29101556 AC



Button Function Button Function

Open Method Navi-
gator. Opens the Method
Navigator where avail-
able methods are listed.

Run. Starts a method run.

Hold. Suspends the
method run, while current
flow rate and valve posi-
tions are sustained.

Pause. Suspends the
method run and stops all
pumps.

Continue. Resumes for
example a held or paused
method run.

End. Permanently ends
the method run.

Customize. Opens the
Customize dialog box
where curve settings, run
data groups and run log
contents can be set.

Connect to Systems.
Opens the Connect to
Systems dialog box where
systems can be connected,
and currently connected
users are displayed.
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4 Installation

About this chapter
This chapter provides the instructions necessary to enable users and service personnel
to install the instrument and the software.

Read the entire Installation chapter before starting to install the ÄKTA avant instru-
ment.

Note: For information on how to how to unpack the ÄKTA avant instrument and
how to lift the instrument onto a laboratory bench see ÄKTA avant
Unpacking Instructions .

In this chapter

Section See page

4.1 Site preparation 41

4.2 Hardware installation 53

4.3 Software installation 66

4.4 Start UNICORN and connect to system 67

4.5 Prime inlets and purge pump heads 69

4.6 Performance tests 86
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4.1 Site preparation

Introduction
This section describes the site planning and the preparations necessary to perform
before installation of an ÄKTA avant system. The purpose is to provide planners and
technical staff with the data needed to prepare the laboratory for the installation.

The laboratory site must be planned and prepared before installing the ÄKTA avant
system. The performance specifications of the system can be met only if the laboratory
environment fulfills the requirements stated in this chapter.

In this section

Section See page

4.1.1 Delivery and storage 42

4.1.2 Room requirements 44

4.1.3 Site environment 47

4.1.4 Power requirements 48

4.1.5 Computer requirements 49

4.1.6 Required materials 50
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4.1.1 Delivery and storage

Introduction
This section describes the requirements for receiving the delivery box and storing the
instrument before installation.

Heavy object. The ÄKTA avant instrument weighs about 119 kg. Use proper lifting
equipment, or be four or more people when moving the instrument. All lifting and
moving must be performed in accordance with local regulations.

When you receive the delivery

• Record on the receiving documents if there is any apparent damage on the delivery
box. Inform your Cytiva representative of such damage.

• Move the delivery box to a protected location indoors.

Delivery box
ÄKTA avant instruments are shipped in a delivery box with the following dimensions
and weight:

Contents Dimensions (mm) Weight

ÄKTA avant instrument
with accessories

1000 × 900 × 800

(width × height × depth)

155 kg

Storage requirements
The delivery boxes should be stored at a protected place indoors. The following storage
requirements must be fulfilled for the unopened boxes:

Parameter Allowed range

Ambient temperature, storage -25°C to 60°C

Relative humidity 20% to 95%, noncondensing

Equipment for transportation
The following equipment is recommended for handling the delivery boxes:
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Equipment Specifications

Pallet mover Suitable for a lightweight pallet 80 × 100 cm

Cart for transporting the
instrument to the lab

Dimensioned to accommodate the size and
weight of the instrument

Unpacking the ÄKTA avant
instrument

For information on how to how to unpack the ÄKTA avant instrument and how to lift the
instrument onto a laboratory bench see ÄKTA avant Unpacking Instructions.
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4.1.2 Room requirements

Introduction
This section describes the requirements for the transportation route and the room
where the ÄKTA avant instrument is placed.

WARNING

Access to power switch and power cord with plug. Do not
block access to the power switch and power cord. The power switch
must always be easy to access. The power cord with plug must
always be easy to disconnect.

Transportation route
Doors, corridors and elevators must have a minimum width of 75 cm to allow for trans-
porting the instrument. Allow additional space for moving around corners.

Space requirements
The following illustration shows the space recommended for the ÄKTA avant system.

Allow space on the laboratory bench for:

• handling of samples and buffers (2 × 30 cm)

• computer and monitor (80 cm)

• access for service (see the following topic)
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Service access
To access the rear panel, the instrument can be rotated on a swivel foot. There must be
at least 20 cm additional space on the bench to allow for free rotation.

WARNING

Rotating the instrument. Make sure that there is always at least
20 cm of free space around the ÄKTA avant instrument to allow for
sufficient ventilation and rotation on the swivel foot. When rotating
the instrument, take care not to stretch or squeeze tubing or
cables. A disconnected cable may cause power interruption or
network interruption. Stretched tubing may cause bottles to fall,
resulting in liquid spillage and shattered glass. Squeezed tubing
may cause increase in pressure, or block liquid flow. To avoid the
risk of knocking over bottles, always place bottles on the buffer
tray, and close the doors before rotating the instrument.

Laboratory bench
The bench must be clean, flat and stable to support the weight of the ÄKTA avant
system, see the following table Equipment weight on page 45.

Equipment dimensions
The outer dimensions of the ÄKTA avant instrument are shown in the following illustra-
tion.

Equipment weight

Item Weight

ÄKTA avant instrument 116 kg
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Item Weight

Computer approximately 9 kg

Monitor approximately 3 kg

Total approximately 130 kg

4 Installation
4.1 Site preparation

4.1.2 Room requirements

46  ÄKTA avant Operating Instructions 29101556 AC



4.1.3 Site environment

Introduction
This section describes the environmental requirements for installation of the ÄKTA
avant instrument.

Environmental conditions
The following general requirements must be fulfilled:

• The room must have exhaust ventilation

• The instrument should not be exposed to sources of heat, such as direct sunlight

• Dust in the atmosphere should be kept to a minimum

The installation site must comply with the following specifications.

Environmental requirements

Parameter Requirement

Allowed location Indoor use only

Ambient temperature, operation 4°C to 35°C

Ambient temperature, storage -25°C to 60°C

Relative humidity, operating 20% to 95%, noncondensing

Relative humidity, non-operating 20% to 95%, noncondensing

Altitude, operation Up to 2000 m

Pollution degree of the intended envi-
ronment

Pollution degree 2

Heat output
The heat output data is listed in the following table.

Component Heat output

ÄKTA avant instrument Typically 400 W

Maximum 800 W

Computer, incl. monitor and printer Typically 300 W

Refer to manufacturer's instructions for
more information.

Total heat output Typically 700 W

Maximum 1100 W
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4.1.4 Power requirements

Introduction
This section describes the electrical power requirements for the ÄKTA avant instru-
ment.

Electrical power requirements
The following table specifies the power requirements.

Parameter Requirement

Supply voltage 100 to 240 V AC ±10%

Frequency 50/60 Hz

Transient overvoltages Overvoltage category II

Max power consump-
tion

800 VA

Number of sockets 1 socket per instrument, up to 3 sockets for computer
equipment

Type of sockets EU or US plugs. Grounded mains sockets, fused or
protected by equivalent circuit breaker.

Location of sockets Maximum 2 m from the instrument (due to length of
mains cable). Extension cables can be used if required.

WARNING

Protective ground. The product must always be connected to a
grounded power outlet.

Quality of power
The mains power supply must be stable and conform to specifications at all times to
ensure reliable operation of the ÄKTA avant instrument. There should be no transient
or slow changes in average voltage outside the limits specified above.
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4.1.5 Computer requirements

Introduction
ÄKTA avant systems are controlled by UNICORN software running on a PC. The PC can
be part of the delivery or be supplied locally.

The PC used must fulfill the recommendations stated in this section.

General computer specifications
For information about compatibility between UNICORN versions and the supported
operating systems and database versions see the UNICORN compatibility matrix at 
cytiva.com/UNICORNcompatibility.

UNICORN Client Database
Server

Workstation
installation

E-License
Server

Min. free disk
space

6 GB 6 GB 12 GB 500 MB

Min. available
RAM

3 GB 3 GB 3 GB 2 GB

Disc format NTFS NTFS NTFS NTFS

Architecture Intel Dual Core (or
faster)

Intel Dual Core
(or faster)

Intel Dual Core (or
faster)

Intel Dual Core
(or faster)

Note: • UNICORN is tested using the English (U.S.) Code 1033 operating system
language version. Using other language versions of the operating system
may cause errors.

• A screen resolution of 1280x1024 or higher is recommended. Parts of the
UNICORN user interface may not be displayed properly using a lower
resolution.

• Changing the default font and changing the font size from 100% in
Windows may cause problems in the UNICORN user interface.

• The Windows basic color scheme is recommended1.

• Using the Windows 7 Aero color scheme is not recommended.

• Windows power save features should be turned off to avoid conflicts with
system operations.

• UNICORN is not compatible with the Windows 7 feature High DPI Aware-
ness, which allows the graphic user interface to be scaled. The interface
scale must remain at 100% to avoid issues with clipping and misaligning
of parts of the UNICORN user interface. Normally, the scale is set at
100% by default.

1 UNICORN must be closed when the color scheme is changed.
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4.1.6 Required materials

Introduction
This section describes the accessories required for the installation and operation of the
ÄKTA avant instrument.

Buffers and solutions
The buffers and solutions listed in the following table are required during the installa-
tion procedure and should be provided at the installation site.

Buffer/solution Required
volume

Scope of use

Distilled water 1 liter Air sensor test, fraction collector
test, Quaternary Valve test and
system test

1% acetone in distilled
water

0.5 liter Quaternary Valve test

1% acetone and 1 M NaCl
in distilled water

0.5 liter System test

20% ethanol 200 ml Priming of the pump piston
rinsing system

Laboratory equipment
The equipment listed in the following table is required during the installation proce-
dure and should be provided at the installation site.

Equipment Specification

Flasks, liquid containers For buffers and waste

Gloves For protection

Protective glasses For protection

Fraction collector tubes and bottles
The tubes and bottles used in the built-in fraction collector must fulfill the require-
ments listed in the following table. Examples of manufacturers are also listed in the
table.
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Tube or
bottle size
(ml)

Diameter (mm) Height (mm) Examples of
manufacturers

Min. Max. Min. Max.

3 10.5 11.5 50 56 Nunc™

5 10.5 12 70 76 VWR™

8 12 13.3 96 102 BD™ Biosciences,
VWR

15 16 17 114 120 BD Biosciences

50 28 30 110 116 BD Biosciences

250 mL bottle L: 55

W: 551

L: 64.5

W: 641

- 121 Nalgene™ ,
Kautex™

1 Length and width of the rectangular bottle base

Deep well plates, requirements
The deep well plates used in the built-in fraction collector must fulfill the requirements
listed in the table below.

Property Specification

No. of wells 24, 48, or 96

Shape of wells Square, not cylindrical

Well volume 10, 5, or 2 ml

Approved deep well plates
The deep well plates listed in the table below are tested and approved by Cytiva to be
used with the built-in fraction collector.

Plate type Manufacturer Part no.

96 deep well plate Cytiva 7701-5200

BD Biosciences 353966

Greiner Bio-One 780270

Porvair Sciences 219009

Seahorse Bioscience S30009

Eppendorf™ 951033405/ 0030 501.306

48 deep well plate Cytiva 7701-5500
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Plate type Manufacturer Part no.

Seahorse Bioscience S30004

24 deep well plate Cytiva 7701-5102

Seahorse Bioscience S30024
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4.2 Hardware installation

About this section
This section describes the installation procedure of an ÄKTA avant system.

Note: For information on how to how to unpack the ÄKTA avant instrument and
how to lift the instrument onto a laboratory bench see ÄKTA avant
Unpacking Instructions .

WARNING

Protective ground. The product must always be connected to a
grounded power outlet.

WARNING

Power cord. Only use power cords with approved plugs delivered
or approved by Cytiva.

WARNING

Access to power switch and power cord with plug. Do not
block access to the power switch and power cord. The power switch
must always be easy to access. The power cord with plug must
always be easy to disconnect.

In this section

Section See page

4.2.1 Install the computer equipment 54

4.2.2 Connect the system units 55

4.2.3 Prepare waste tubing 58

4.2.4 Install the Barcode Scanner 2-D and the pH electrode 61

4.2.5 Prepare the pump rinsing system 62

4.2.6 Start the instrument and the computer 65

4 Installation
4.2 Hardware installation

ÄKTA avant Operating Instructions 29101556 AC 53



4.2.1 Install the computer equipment

Introduction
The computer is supplied as a part of the ÄKTA avant delivery, or supplied locally.

Unpacking and installing
Unpack and install the computer according to the manufacturer's instructions.

NOTICE

Any computer used with the equipment must comply with
IEC 60950 and be installed and used according to the manufac-
turer's instructions.
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4.2.2 Connect the system units

Introduction
The following interconnections must be made:

• power supply to the ÄKTA avant instrument

• power supply to the computer equipment

• network connection between the computer and the ÄKTA avant instrument

WARNING

• Power cord. Only use power cords with approved plugs deliv-
ered or approved by Cytiva.

• Supply voltage. Before connecting the power cord, make sure
that the supply voltage at the wall outlet corresponds to the
marking on the instrument.

Connector illustration
The following illustration shows the location of the connectors.

123

Part Function

1 Power input connector

2 Network connector (Ethernet)
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Part Function

3 UniNet-9 connectors

Note:

Termination plugs must be connected to the connectors that are not in
use.

Other connectors are for use by authorized service engineers only.

NOTICE

Misuse of UniNet-9 connectors. The UniNet-9 connectors at
the rear panel should not be mistaken for Firewire connectors. Do
not connect any external equipment to the UniNet-9 connectors.
Do not disconnect or move the UniNet-9 bus cable.

Connect power to the ÄKTA avant
instrument

Follow the instructions to connect power to the ÄKTA avant instrument.

Step Action

1 Select the correct power cord to be used. Each instrument is delivered with 2
alternative power cords:

• Power cord with US-plug, 2 m

• Power cord with EU-plug, 2 m

Discard the unused power cord.

2 Connect the power cord to the Power input connector on the back of the
instrument and to a grounded wall outlet 100 to 240 VAC , 50 to 60 Hz.

3 Attach the power cord to the rear of the instrument using the cable clip.
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Connect power to computer
equipment

Follow the manufacturer's instructions to connect power to the computer, monitor
and local printer (if used).

Connect to network

Follow the instructions to make network connections.

Step Action

1 Connect a network cable between the network connector (Ethernet) on the
back of the instrument and the computer network card dedicated to ÄKTA.

The illustration shows the symbol of the Ethernet connector.

2 If the computer is to be connected to an external network, connect a
network cable between the main network card of the computer and a
network wall outlet.

Note:

If the computer has not been supplied by Cytiva and if network configuration
is to be used, see UNICORN Administration and Technical Manual for further
information on network settings.
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4.2.3 Prepare waste tubing

Location of waste tubing
All waste tubing is found on the rear of the instrument, see the following illustration.

1 2

Part Description

1 Waste tubing from the injection valve, the pH valve and the outlet valve
(pieces of tubing marked W, W1, W2 and W3).

2 Waste tubing from the fraction collector and the buffer tray.

Prepare the waste tubing

Follow the instructions to prepare the waste tubing.
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Step Action

1 Place the four pieces of waste tubing from the injection valve, the pH valve
and the outlet valve (pieces of tubing marked W, W1, W2 and W3) in a vessel
placed below the bench.

NOTICE

The maximum level of the waste vessel for the waste
tubing from the valves must be lower than 30 cm above
the lab bench.

2 Place the three pieces of waste tubing from the fraction collector and the
buffer tray in a waste vessel placed below the bench.

NOTICE

The maximum level of the waste vessel for the waste
tubing from the fraction collector and the buffer tray
must be lower than the bench height.

3 Cut the waste tubing from the fraction collector and the buffer tray to appro-
priate length. It is important that the tubing is not bent and will not be
submerged in liquid during the run.

Note: If the tubing is too short, replace it with new tubing. Do not lengthen the
tubing as this might cause obstruction of the tubing and flooding in the frac-
tion collector chamber.

4 Installation
4.2 Hardware installation

4.2.3 Prepare waste tubing

ÄKTA avant Operating Instructions 29101556 AC 59



CAUTION

Make sure that the waste vessels will hold all the produced volume
of the run. For ÄKTA avant 25, a suitable waste vessel should typi-
cally have a volume of 2 to 10 liters. For ÄKTA avant 150, a waste
vessel should have a volume of 40 liters.
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4.2.4 Install the Barcode Scanner 2-D and the pH electrode

Introduction
This section describes how to install the Barcode Scanner 2-D and the pH electrode.

Install the barcode scanner
Connect the cable of the Barcode Scanner 2-D to the scanner head and to a USB port
on the computer.

Install the pH electrode

If pH monitoring is to be used, you need to replace the dummy electrode mounted at
delivery with a pH electrode.

CAUTION

pH electrode. Handle the pH electrode with care. The glass tip
may break and cause injury.

Follow the instructions to install the pH electrode.

Step Action

1 Unpack the pH electrode. Make sure that the electrode is not broken or dry.

2 Unscrew the dummy electrode from the flow cell.

3 Pull off the plug from the connector on the front of the pH valve, and store
the plug together with the dummy electrode.

4 Remove the cover from the tip of the pH electrode.

5 Carefully insert the electrode in the flow cell. Tighten the locking ring by
hand to secure the electrode.

6 Connect the pH electrode cable to the connector on front of the pH valve.
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4.2.5 Prepare the pump rinsing system

Illustration of the pump piston
rinsing systems

Part Description

1 Inlet tubing to the sample pump piston rinsing system

2 Outlet tubing from the sample pump piston rinsing system

3 Inlet tubing to the system pump piston rinsing system

4 Outlet tubing from the system pump piston rinsing system

Prime the pump piston rinsing
system

Follow the instructions to fill the pump piston rinsing systems with rinsing solution. See
the tubing configuration of the rinsing systems in Illustration of the pump piston rinsing
systems on page 62.
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Step Action

1 Unscrew the rinsing system tubes from the holders.

2 Fill each of the rinsing system tubes with 50 ml of 20% ethanol.

3 Screw the rinsing solution tubes back in the holders.

4 Immerse the inlet tubing to the system pump piston rinsing system in one of
the rinsing solution tubes.

Note:

Make sure that the inlet tubing reaches close to the bottom of the rinsing
solution tube.

5 Immerse the inlet tubing to the sample pump piston rinsing system in the
other rinsing solution tube.

Note:

Make sure that the inlet tubing reaches close to the bottom of the rinsing
solution tube.

6 Connect a 25 to 30 ml syringe to the outlet tubing of the system pump piston
rinsing system. Draw liquid slowly into the syringe.
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Step Action

7 Disconnect the syringe and discard its contents.

8 Immerse the outlet tubing in the rinsing solution tube where the inlet tubing
of the system pump piston rinsing system is immersed.

9 Connect a 25 to 30 ml syringe to the outlet tubing from the sample pump
piston rinsing system. Draw liquid slowly into the syringe.

10 Disconnect the syringe and discard its contents.

11 Immerse the outlet tubing in the rinsing solution tube where the inlet tubing
of the sample pump piston rinsing system is immersed.

12 Fill the rinsing solution tubes so that each of the tubes contains 50 ml of 20%
ethanol.
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4.2.6 Start the instrument and the computer

Introduction
This section describes how to start the instrument and the computer.

Instruction

Follow the instructions to start the instrument and the computer.

Step Action

1 Switch on the instrument by pressing the Power switch to the I position.

Result:

The instrument starts and the Instrument display states Not connected.

2 Turn on the computer and monitor according to the manufacturer's instruc-
tions.
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4.3 Software installation

Introduction
This section gives an overview of the different UNICORN installation types.

The software should be installed by an assigned UNICORN system administrator.
Detailed information about software installation and configuration is available in the
UNICORN Administration and Technical Manual.

Software installations
You can install UNICORN in one of the following configurations:

• as a complete UNICORN installation on a stand-alone workstation (full installation)

• as a UNICORN database and license server (custom installation)

• as a UNICORN software client and instrument server software on a network client
station (custom installation)
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4.4 Start UNICORN and connect to system

Introduction
This section describes how to start and log on to UNICORN and how to connect the
instrument to UNICORN.

Prerequisites
UNICORN must be correctly installed according to instructions in the UNICORN
Administration and Technical Manual.

Start UNICORN and log on

Follow the instructions to start UNICORN and log on to the program. A valid e-license
must be available for the workstation. See UNICORN Administration and Technical
Manual for more information about e-licenses.

Step Action

1 Double-click the UNICORN icon on the desktop.

Result:

The Log On dialog box opens.

2 In the Log On dialog box:

• select User Name

and

• enter Password.

Note:

It is also possible to select the Use Windows Authentication checkbox
and enter a network ID in the User Name field.

• click OK.

Result:

The selected UNICORN modules open.
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Connect to system

Follow the instructions to connect the instrument to UNICORN.

Note: The system must have been defined by the UNICORN system administrator.

Step Action

1 In the System Control module, click the Connect to Systems button.

Result:

The Connect to Systems dialog box opens.

2 In the Connect to Systems dialog box:

• Select a system check box.

• Click Control for that system.

• Click OK.

Result:

The selected instrument can now be controlled by the software.

Tip:

If UNICORN is unable to connect to the selected instrument, see Chapter
Troubleshooting in ÄKTA avant User Manual.
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4.5 Prime inlets and purge pump heads

About this section
Before using the sample pump or system pumps it is important to do the following:

• Prime the inlets (fill the inlets with liquid).

• Purge the pumps (remove air from the pump heads).

This section describes how to prime the buffer inlets, sample inlets, and Q inlets, and
how to purge the system pumps and the sample pump.

In this section

Section See page

4.5.1 Prime buffer inlets and purge system pumps 70

4.5.2 Prime sample inlets and purge Sample Pump 77

4.5.3 Prime Q inlets 82
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4.5.1 Prime buffer inlets and purge system pumps

Overview
The procedure consists of the following stages:

Stage Description

1 Prime all inlet tubing to be used during the run.

2 Validate priming of inlet tubing.

3 Purge System Pump B if pressure signal indicates air bubbles.

4 Validate purge of System Pump B.

5 Purge System Pump A if pressure signal indicates air bubbles.

6 Validate purge of System Pump A.

7 End the run.

Note: To increase life length of the pump sealing rings, make sure that the pump
rinsing system is filled with fresh rinsing solution.

Tip: The procedures for purging the pump heads and priming the inlets using the
Process Picture, are described in the following topic. It is also possible to
perform the procedures from the Manual instructions dialog box.

Prime inlet tubing

Follow the instructions to fill all A and B inlet tubing to be used in the run with appro-
priate buffer/solution.

Step Action

1 Make sure that all inlet tubing that is to be used during the method run is
placed in the correct buffer.

2 Open the System Control module.
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Step Action

3 In the Process Picture:

• Click the inlet valve icons. (Click both the Inlet A and Inlet B icons, one at
a time, if both inlets are to be primed.)

• Click the position of the inlet to be filled. Fill the positions in reverse
alphabetical order and start with the highest number. For example, if all
the seven inlets in Inlet Valve B are to be filled, click them in the following
order: B7, B6 . . . B1, assuming that B1 is the starting buffer.

Result:

The inlet valve switches to the selected port.

4 Connect a 25 to 30 ml syringe to the purge valve of one of the pump heads of
System Pump B. Make sure that the syringe fits tightly into the purge
connector.

5 Open the purge valve by turning it counter-clockwise about three quarters
of a turn. Draw liquid slowly into the syringe until the liquid reaches the
pump.

6 Close the purge valve by turning it clockwise. Disconnect the syringe and
discard its contents.

7 Repeat steps 3 to 6 for each piece of inlet tubing that is to be used during the
run. In the final inlet position, draw liquid into the syringe through both purge
valves.
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Step Action

8 Check that there is no air left in the pump by following the instructions in 
Validate prime or purge of System Pump A or B or Sample Pump on page
75. If air bubbles are indicated, follow the instructions in Purge System
Pump B on page 72

Purge System Pump B

If the priming was done thoroughly and the final buffer was drawn all the way into the
syringe and the validation of the priming showed that there was no air left in the pump
it is not necessary to purge System Pump B.

However, if the pressure signal indicated air bubbles left in the pump, follow these
instructions to purge both pump heads of System Pump B:

Step Action

1 Make sure that the piece of waste tubing connected to the injection valve
port W1 is placed in a waste vessel.

2 In the Process Picture:

• Click the Injection valve icon and then click System pump waste.

Result:

The injection valve switches to waste position. This is necessary to achieve a
low back pressure during the purge procedure.
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Step Action

3 In the Process Picture:

• Click the Inlet valve B icon.

• Click the position of one of the inlets that will be used at the beginning of
the run.

Result:

The inlet valve switches to the selected port.

4 In the Process Picture:

• Click the System pumps icon.

• Set Conc % B to 100% B and click Set % B.

• Set the System flow to 1.0 ml/min for ÄKTA avant 25 or 5.0 ml/min for
ÄKTA avant 150.

• Click Set flow rate.

Result:

Only System Pump B is active, and a system flow through injection valve
waste starts.
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Step Action

5 Connect a 25 to 30 ml syringe to the purge valve of the left pump head of
System Pump B. Make sure that the syringe fits tightly into the purge
connector.

6 Open the purge valve by turning it counter-clockwise about three quarters
of a turn. Draw 5 to 10 ml of liquid slowly into the syringe with a rate of about
1 ml/s.

7 Close the purge valve by turning it clockwise. Disconnect the syringe and
discard its contents.

8 Connect the syringe to the purge valve on the right pump head of System
Pump B, and repeat steps 6 to 8. Keep the system flow running.

9 Check that there is no air left in the pump by following the instructions in 
Validate prime or purge of System Pump A or B or Sample Pump on page
75.
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Purge System Pump A

Purge both pump heads of System Pump A by following the same procedure as in 
Purge System Pump B, on page 72, but replace step 3 and 4 with the following:

Step Action

1 In the Process Picture:

• Click the Inlet valve A icon.

• Click the position of one of the inlets that will be used at the beginning of
the run.

Result:

The inlet valve switches to the selected port.

2 In the Process Picture:

• Click the System pumps icon.

• Set Conc % B to 0% B and click Set % B.

Result:

Only System Pump A is active.

Validate prime or purge of System
Pump A or B or Sample Pump

Follow these instructions to check that there is no air left in the pump after performing
a prime or a purge.
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Step Action

1 In the Process Picture:

• Click on the Injection valve and select Manual load.

Result:

The injection valve switches to manual load position.

2 Make sure that the pump flow is on.

3 In the Chromatogram pane:

• Check the PreC pressure curve.

• If the PreC pressure do not stabilize within a few minutes there may be
air left in the pump. Purge the pump once more then see ÄKTA avant User
Manual.

End the run
Click the End button in the System Control toolbar to end the run.

4 Installation
4.5 Prime inlets and purge pump heads

4.5.1 Prime buffer inlets and purge system pumps

76  ÄKTA avant Operating Instructions 29101556 AC



4.5.2 Prime sample inlets and purge Sample Pump

Overview
The procedure consists of the following stages:

Stage Description

1 Prime all sample inlet tubing to be used during the run.

2 Validate priming of inlet tubing.

3 Purge the sample pump if pressure signal indicates air bubbles.

4 Validate purge of the samle pump.

5 End the run.

Note: To increase life length of the pump sealing rings, make sure that the pump
rinsing system is filled with fresh rinsing solution.

Prime sample inlets

Follow the instructions below to fill all sample inlet tubing, to be used in the run, with
appropriate buffer or sample solution.

Step Action

1 Make sure that all sample inlet tubing that is to be used during the method
run is immersed in the correct samples or buffer.

2 Make sure that the waste tubing connected to injection valve port W2 is
immersed in a waste vessel.

3 Open the System Control module.
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Step Action

4 In the Process Picture

• Click the Sample inlet valve icon.

• Select the position of the inlet to be filled. Start at the inlet position with
the highest number and end at the position with the lowest number or
the buffer position (assuming that the first sample to run is connected to
inlet 1 etc.).

Result:

The sample inlet valve switches to the selected port.

5 Connect a 25 to 30 ml syringe to one of the purge valves of the pump heads
in the sample pump. Make sure that the syringe fits tightly into the purge
connector.

6 Open the purge valve by turning it counter-clockwise about three-quarters
of a turn. Draw slowly with the syringe until the sample just passes the
Sample inlet valve.

7 Close the purge valve by turning it clockwise. Disconnect the syringe and
discard its contents.

8 Repeat steps 4 to 7 for each sample inlet that is to be used in the method
run. The final sample or the buffer from the buffer position should be drawn
all the way through both pump heads into the syringe.
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Step Action

9 Check that there is no air left in the pump by following the instructions in 
Validate prime or purge of System Pump A or B or Sample Pump on page 75.
If air bubbles are indicated, follow the instructions in Purge Sample Pump on
page 79.

Purge Sample Pump

If the priming was done thoroughly and the final buffer was drawn all the way into the
syringe and the validation of the priming showed that there was no air left in the pump
it is not necessary to purge the sample pump.

However, if the pressure signal indicated air bubbles left in the pump, follow the
instruction below to purge both the pump heads of the sample pump.

Step Action

1 Make sure that all sample inlet tubing that is to be used during the method
run is immersed in the correct buffers.

2 Make sure that the waste tubing connected to injection valve port W2 is
immersed in a waste vessel.

3 Open the System Control module.

4 In the Process Picture:

• Click the Injection valve icon, and then click Sample pump waste.

Result:

The injection valve switches to waste position. This is necessary to achieve a
low back pressure during the purge procedure.
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Step Action

5 In the Process Picture:

• Click the Sample inlet icon, then click Buffer.

• Click the Sample pump icon: Set the Sample flow to 1.0 ml/min for
ÄKTA avant 25 or 5.0 ml/min for ÄKTA avant 150.

• Click Set flow rate.

Result:

The sample pump flow starts.

6 Connect a 25 to 30 ml syringe to the left purge valve of the sample pump.
Make sure that the syringe fits tightly into the purge connector.

7 Open the purge valve by turning it counter-clockwise about three-quarters
of a turn. Draw 5 to 10 ml of liquid slowly into the syringe with a rate of about
1 ml/s.

8 Close the purge valve by turning it clockwise. Disconnect the syringe and
discard its contents.
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Step Action

9 Connect the syringe to the right purge valve on the sample pump, and
repeat step 6 to 8.

10 Check that there is no air left in the pump by following the instructions in 
Validate prime or purge of System Pump A or B or Sample Pump on page 75.

End the run
Click the End button in the System Control toolbar to end the run.
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4.5.3 Prime Q inlets

Overview
The procedure consists of the following stages:

Stage Description

1 Prime all Q inlet tubing.

2 Validate priming of Q inlet tubing.

3 Purge Quaternary Valve and the system pumps if pressure signal indi-
cates air bubbles.

4 Validate purge of Quarternary Valve and system pumps.

5 End the run.

Prime the Q inlets

Follow the instructions to prime the Q inlets.

Step Action

1 Make sure that the pieces of inlet tubing marked A1, B1 and Q1-Q4 are
immersed in the correct buffers. The A1 and B1 positions are used for pump
synchronization and these lines should already be primed.

2 In the Manual instructions dialog box:

• Select Pumps and pressures →Quaternary start concentrations.

• Set Start concentration Q1 to 100%. Make sure that the other start
concentrations are set to 0%.

• Select Pumps and pressures →System flow and set Flow rate to 0.01
ml/min.
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Step Action

3 Connect a 25 to 30 ml syringe to one of the purge valves of either of the
system pumps. Make sure that the syringe fits tightly into the purge
connector.

4 Open the purge valve by turning it counterclockwise about 3 quarters of a
turn. Draw 10 ml of liquid into the syringe. Check that the Q1 inlet is filled
with liquid.

5 Close the purge valve by turning it clockwise. Disconnect the syringe and
discard its contents.

6 Repeat steps 2 to 5 for Q2, Q3 and Q4 respectively by setting the respective
Quaternary start concentration to 100%.

Tip:

The inlet tubing that is immersed in distilled water should be the last piece of
inlet tubing to be primed.

Tip:

If you will perform a BufferPro run, end with either Q1 or Q2.

7 Check that there is no air left in the pump by following the instructions in 
Validate prime or purge of System Pump A or B or Sample Pump on page 75.
If air bubbles are indicated, follow the instructions in Purge Quaternary Valve
and the system pumps, on page 83.

Purge Quaternary Valve and the
system pumps

If the priming was done thoroughly and the final buffer was drawn all the way into the
syringe and the validation of the priming showed that there was no air left in the pump
it is not necessary to purge Quaternary Valve and the system pumps.
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However, if the pressure signal indicated air bubbles left in the valve or the pump,
follow these instructions to purge Quaternary Valve, System Pump A and System Pump
B. Note that both pump heads of each system pump have to be purged.

Step Action

1 In the Manual instructions dialog box:

• Select Pumps and pressures →Pump wash, and click All in the
BufferPro / Q inlets list.

Result:

A simultaneous pump wash of all the Q inlets is started. This will remove air
from Quaternary Valve.

2 Wait until the pump wash is completed.

• Select Pumps and pressures →Quaternary start concentrations.

• Set Start concentration Q1 to 100%. Make sure that the other start
concentrations are set to 0%.

3 Select Pumps and pressures →System flow and set Flow rate to 0.01
ml/min.

4 Connect a 25 to 30 ml syringe to the left purge valve of the selected system
pump. Make sure that the syringe fits tightly into the purge connector.
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Step Action

5 Open the purge valve by turning it counterclockwise about 3 quarters of a
turn. Draw 10 ml of liquid slowly into the syringe with a rate of about 1 ml per
second.

6 Close the purge valve by turning it clockwise. Disconnect the syringe and
discard its contents.

7 Repeat steps 3 to 5 for the other three purge valves of the system pumps to
get rid of air in all pump heads. Keep the system flow running during this
procedure.

8 Check that there is no air left in the pump by following the instructions in 
Validate prime or purge of System Pump A or B or Sample Pump on page 75.

End the run
Click the End button in the System Control toolbar to end the run.

4 Installation
4.5 Prime inlets and purge pump heads

4.5.3 Prime Q inlets

ÄKTA avant Operating Instructions 29101556 AC 85



4.6 Performance tests

Introduction
Before taking the ÄKTA avant instrument into use, run performance tests to check the
function of the equipment. See ÄKTA avant User Manual for further instructions.
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5 Prepare the system for a run

About this chapter
This chapter describes the preparations necessary before starting a run.

In this chapter

Section See page

5.1 Before you prepare the system 88

5.2 Prepare the flowpath 90

5.3 Prime buffer inlets and purge system pumps 94

5.4 Connect a column 95

5.5 Set pressure alarms 99

5.6 Calibrate the pH monitor 101

5.7 Prepare the built-in fraction collector 103

5.8 Prepare for a run at cold temperature 109
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5.1 Before you prepare the system

Introduction
It is important to prepare the system in accordance with the settings in the method to
be run. Before preparing the system, verify the settings in the Method Editor and
make sure that all accessories to be used are available.

WARNING

• Do not use ÄKTA avant if it is not working properly, or if it has
suffered any damage, for example:

- damage to the power cord or its plug

- damage caused by dropping the equipment

- damage caused by splashing liquid onto it

• Always use appropriate Personal Protective Equipment (PPE)
during operation and maintenance of this product.

• Do not use any accessories not supplied or recommended by
Cytiva.

• Fire Hazard. Before starting the system, make sure that there is
no leakage.

Checklist
Prepare the instrument and accessories according to the following information from
the Method Editor:

• which valve ports to use for inlets and outlets

• which column type to use

• which column position to use

• which buffers and samples to prepare

• which sample application technique to use

• make sure that the the pH electrode is connected, if applicable

• which cassettes with corresponding deep well plates and/or tubes to use in the frac-
tion collector, if applicable

• if it is a reversed phase chromatography (RPC) run, make sure to follow the safety
precautions below

5 Prepare the system for a run
5.1 Before you prepare the system
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WARNING
When using flammable liquids with the ÄKTA avant instru-
ment, follow these precautions to avoid any risk of fire or
explosion.

• Fraction collector. Do not fractionate flammable liquids in the
built-in fraction collector. When running RPC methods, collect
fractions through the outlet valve or the optional external Frac-
tion collector F9-R.

• RPC runs with 100% acetonitrile and system pressure
above 5 MPa (50 bar) in ÄKTA avant 25 . Always replace the
green PEEK tubing between the used system pump and the
pump pressure monitor with orange PEEK tubing, i.d. 0.5 mm,
before running RPC with 100% acetonitrile. Set the system
pressure alarm to 10 MPa (100 bar).

• RPC runs with 100% acetonitrile in ÄKTA avant 150 .
Always replace the beige PEEK tubing between the used system
pump and the pump pressure monitor before running RPC with
100% acetonitrile. Replace it with green PEEK tubing, i.d. 0.75
mm.

5 Prepare the system for a run
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5.2 Prepare the flowpath

Introduction
The flow path contains tubing, valves, pumps and monitors. This section gives an over-
view of the flow path and describes how to prepare the flow path before a run.

CAUTION

• Fasten bottles and cassettes. Always fasten bottles and
cassettes to the rails at the front and side panel. Use appro-
priate holders for bottles. Shattered glass from falling bottles
may cause injury. Spilled liquid may cause fire hazard and
personal injury.

• Max. weight on buffer tray. Do not place containers with a
volume of more than 10 liters each on the buffer tray. The total
allowed weight on the buffer tray is 40 kg.

• Avoid spillage and overflow. Make sure that the system is
prepared according to the settings in the method to be run. For
example make sure that the waste tubing is inserted in an
appropriate waste container and secured in place.

5 Prepare the system for a run
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Illustration of the flow path
The following illustration shows an overview of the standard flow path.
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Part Description

1 Pressure monitor

2 Sample pump

3 Sample inlet valve

4 Quaternary valve

5 Inlet valve A

6 Inlet valve B

7 System pump B

8 System pump A

9 Pressure monitor

5 Prepare the system for a run
5.2 Prepare the flowpath

ÄKTA avant Operating Instructions 29101556 AC 91



Part Description

10 Mixer

11 Injection valve

12 Sample loop or Superloop™

13 Column valve

14 Column

15 UV monitor

16 Conductivity monitor

17 Flow restrictor

18 pH valve with pH monitor

19 Outlet valve

20 Fraction collector

Prepare the inlet tubing
Connect inlet tubing to the inlet ports that are to be used, and immerse all inlet tubing
that is to be used during the method run in the correct buffers.

Waste ports
The following table shows the waste ports of Injection Valve, pH Valve and Outlet Valve.

Valves and ports Illustrations

Injection Valve (label
V9-Inj and V9H-Inj)

Waste ports:

• W1, W2
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Valves and ports Illustrations

pH Valve (label V9-pH
and V9H-pH)

Waste port:

• W3

Outlet Valve (label V9-
O and V9H-O)

Waste port:

• W

Prepare the waste tubing
Make sure that the waste tubing is prepared according to the instructions in Section
4.2.3 Prepare waste tubing, on page 58.

Prepare the outlet tubing
Connect outlet tubing to the outlet ports of the outlet valve that are to be used during
the run. If a fraction collector is to be used, make sure that tubing is connected
between the outlet valve Frac port and the fraction collector, and prepare the fraction
collector. Otherwise, immerse the outlet tubing in suitable tubes or flasks.

Plug unused valve ports
It is recommended to plug all unused valve ports with stop plugs before starting a run.
See User Manual 29119969 for information about connectors.
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5.3 Prime buffer inlets and purge system pumps

Introduction
Before you start the system pumps, it is important to do the following:

• Prime the inlets (fill the buffer inlets with liquid).

• Purge the system pumps (remove air from the pump heads).

For instructions on how to prime the inlets and purge the system pumps, see Section
4.5 Prime inlets and purge pump heads, on page 69.
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5.4 Connect a column

Introduction
This section describes how to connect a column to the instrument using a column
holder and without introducing air into the flow path. Several types of column holders
are available for the ÄKTA avant instrumen, see ÄKTA avant User Manual.

WARNING

Before connecting a column, read the instructions for use of the
column. To avoid exposing the column to excessive pressure, make
sure that the pressure limit is set to the specified maximum pres-
sure for the column.

Methods automatically include pressure alarms based on the specifications of the
chosen column type. However, when running manual runs you have to set the pressure
limits yourself. Also, to protect the column media, special settings are needed. See 
Section 5.5 Set pressure alarms, on page 99 for more information on pressure alarms.

Note: Do not overtighten when connecting columns. Overtightening might
rupture the connectors or squeeze the tubing and thereby result in high
back pressure.

Attach a column holder and connect a
column

Follow the instructions to connect a column to the instrument. Always use a column
holder. The column is connected to two opposite parts of the column valve, using
appropriate tubing and connectors.

Step Action

1 Attach an appropriate column holder to the rail on the instrument.
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Step Action

2 Attach the column to the column holder.

3 Connect a suitable tubing to a column valve port, for example port 1A if
column position 1 was chosen in the method to be run.

4 In the Process Picture:

• Click the Column valve icon.

• Click, e.g., Position 1 and Down flow.

• Click Set position

Result:

The column valve switches to position 1.
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Step Action

5 In the Process Picture:

• Click the System pumps icon.

• Enter a low System flow (e.g., 0.2 ml/min).

• Click Set flow rate.

Result:

A system flow of 0.2 ml/min starts.

6 When buffer leaves the tubing on port 1A (if port 1A was chosen in the
method to be run) in a continuous mode and the top part of the column is
filled with buffer, connect the tubing to the top of the column.

7 Connect a piece of tubing to the bottom of the column.
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Step Action

8 When buffer leaves the tubing at the bottom of the column in a continuous
mode, connect this piece of tubing to the column valve. Use the port oppo-
site to the one already connected to the column, in this example port 2B.

9 Click the End button in the System Control toolbar to end the run.
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5.5 Set pressure alarms

Introduction
The columns can be protected by two different types of pressure alarms:

• The pre-column pressure alarm protects the column hardware.

• The delta-column pressure alarm protects the column media.

The column valves V9-C and V9H-C have built-in pressure sensors that automatically
measure the pre-column and delta-column pressure.

See the instructions in the next topic to set the pressure alarm for the column to be
used in the run and, if applicable, to set the parameters for the tubing dimensions.

Note: Remember to lower the system pressure alarm and sample pressure alarm
if the optional UV Monitor U9-L and/or the optional second Conductivity
Monitor C9 is used on the high pressure side in the system (before the
column[s]).

NOTICE

UV and conductivity flow cells on the high pressure side.
When placing UV and/or conductivity flow cells on the high pres-
sure side of the column, the UV flow cell has a maximum pressure
limit of 2 MPa (20 bar) and the conductivity flow cell has a
maximum pressure limit of 5 MPa (50 bar).

Pre-column pressure alarms
It is important that the pre-column pressure alarm is set during all runs where a
column is used. The pressure alarm can be set in: the method to be run, the System
Settings dialog box, or during a manual run.

Pre-column pressure alarm limits are automatically set in the method when a column
from the column list is selected in the method. Refer to UNICORN Method Manual for
more information on pressure alarms.

Set pressure alarms

Pressure alarm limits may be set manually in System Control. The example below
describes how to set the high pressure limit for the column. Other alarms are set in a
corresponding way.

Step Action

1 In the System Control module, on the Manual menu, click Execute
Manual Instructions .

Result:

The Manual instructions dialog box opens.
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Step Action

2 In the Instructions box, select Alarms →Alarm pre column pressure.

3 Click Enabled in the Mode field.

4 • Enter the high pressure limit in the High alarm box.

• Click Execute.
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5.6 Calibrate the pH monitor

Introduction
If pH will be measured during the chromatographic run, the pH monitor should be cali-
brated before the run is started. Use two pH calibration buffers with a difference of at
least one pH unit. Preferably use a pH standard buffer pH 4 or 7 as the first calibration
point, and a pH standard buffer close to the lowest or highest pH you need to measure
as your second point. Allow the buffers to reach the operating temperature before use.

Note: Do not run a system flow during pH calibration.

Calibrate the pH monitor

CAUTION

pH electrode. Handle the pH electrode with care. The glass tip
may break and cause injury.

Follow the instructions to perform the calibration.

Step Action

1 Open the System Control module. On the System menu, click Calibra-
tion.

Result:

The Calibration dialog box opens.

2 Select pH in the Monitor to calibrate list.

3 Click Prepare for calibration.

Result:

The pH valve switches to the calibration position.

4 Enter the pH of the first pH standard buffer in the pH for buffer 1 box.
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Step Action

5 Fill a syringe with approximately 10 ml of the first pH standard buffer.
Connect the syringe to the Luer connector in pH valve port Cal, and inject
the buffer.

6 When the Current value is stable, click Calibrate.

7 Wash the pH flow cell by injecting water into pH valve port Cal using a new
syringe.

8 Enter the pH of the second pH standard buffer in the pH for buffer 2 box.

9 Repeat steps 5 to 6 using the second pH standard buffer.

Result:

Calibration date and time are displayed in the dialog box, and also values for
Calibrated electrode slope and Asymmetry potential at pH 7.

10 Is the Calibrated electrode slope ≥ 80% and the Asymmetry potential
at pH 7 inside the interval ±60 mV?

• If Yes: Click Close to switch the pH valve back to the default position, and
to close the Calibration dialog box.

• If No: Clean the pH electrode, and repeat the calibration procedure. If this
does not help, replace the electrode. For information about cleaning and
replacing the pH electrode, see ÄKTA avant User Manual, Chapter
Maintenance.
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5.7 Prepare the built-in fraction collector

Introduction
This section describes how to prepare the built-in fraction collector. For detailed infor-
mation regarding the types of deep well plates, tubes and cassettes, see ÄKTA avant
User Manual.

WARNING

Fraction collector. Do not fractionate flammable liquids in the
built-in fraction collector. When running RPC methods, collect frac-
tions through the outlet valve or the optional external Fraction
collector F9-R.

Available cassettes, trays and racks
The following Cassettes and racks are available:

• Cassette 3 ml tubes (for 40 tubes)

• Cassette 5 ml tubes (for 40 tubes)

• Cassette 8 ml tubes (for 24 tubes)

• Cassette 15 ml tubes (for 15 tubes)

• Cassette 50 ml tubes (for 6 tubes)

• Cassette for deep well plate (24, 48, 96 wells)

• Cassette tray (for six cassettes)

• Rack for 50 ml tubes (for 55 tubes)

• Rack for 250 ml bottles (for 18 bottles)

Workflow for preparing the built-in
fraction collector

Before starting to prepare the built-in fraction collector, check the fractionation
settings in the method to be run. Perform the steps described below according to the
settings in the method.

Step Operator actions Reference to instructions

1 Insert the cassette tray or a rack for
tubes or bottles.

See Prepare and insert the cassette
tray below.

2 Change the System Settings in
UNICORN to set the fractionation
mode and other settings for frac-
tion collection.

See UNICORN System Control
Manual.

Available System Settings are
described in ÄKTA avant User
Manual.
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Prepare cassettes and insert the
cassette tray

Follow the instructions to prepare the fraction collector before a run.

Step Action

1 If you are to use cassettes with the QuickRelease function, first open the
cassettes.

2 Place the tubes and deep well plates in the cassettes. Make sure that the
deep well plates are rotated so that the well marked A1 is positioned above
the A1 marking on the cassette.
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Step Action

3 Close the cassettes that have the QuickRelease function.

4 Place the cassettes on the cassette tray. Make sure that the cassette type
code (see the illustration) faces the front of the tray marked with the Cytiva
monogram.

5 Open the fraction collector drawer by pressing the handle upwards, and
pulling out the drawer.
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Step Action

6 Place the cassette tray on the tray support of the fraction collector drawer.
Make sure that the front of the tray (marked with the Cytiva monogram)
faces the front of the drawer and is hooked onto the two pins.

7 Close the drawer. Make sure that it snaps into closed position.

Result:

After the door has been closed, the fraction collector performs a Full scan of
the cassette type code of each cassette to identify the cassette types, see 
Cassette and tray identification on page 107.

Prepare a rack for 50 ml tubes or 250
ml bottles

Step Action

1 Place 50 ml tubes or 250 ml bottles in the corresponding rack (rack with 50
ml tubes shown in illustration).
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Step Action

2 Open the fraction collector drawer by pressing the handle upwards, and
pulling out the drawer.

3 Place the rack on the tray support of the fraction collector drawer. Make sure
that the front of the rack (marked with the Cytiva monogram) faces the front
of the drawer and is hooked onto the two pins.

4 Close the drawer. Make sure that it snaps into closed position.

Cassette and tray identification
When the door of the fraction collector is closed automatic scanning is performed.
There are two types of scanning procedures:

• Full scan: Scanning of cassette type codes to determine which types of cassettes
are used, and scanning of rows and columns in deep well plates to identify which
types of plates are used (24, 48, or 96 wells). Full scan is performed only when the
system is in state Ready.
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• Quick scan: Scanning of cassette type codes to determine which type of cassettes
are used. Quick scan is performed during the run to ensure that correct cassettes
are placed in the fraction collector.

WARNING

Moving parts in fraction collector. Do not open the fraction
collector drawer when the fraction collector is active. If you need to
access the fraction collector, press Pause, and make sure that the
movement has stopped before opening the drawer.

View fraction collector content
To view the content of the Fraction collector, open the System control module. On the
View menu, click Fraction Collector Content.
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5.8 Prepare for a run at cold temperature

Introduction
To fit the ÄKTA avant instrument in a cold cabinet, the foldable door and pump cover
can be removed. For instructions, see ÄKTA avant User Manual. When using the instru-
ment in a cold room or cold cabinet, make sure to follow the precautions listed in the
next topic.

Precautions concerning runs in a cold
temperature

NOTICE

• Avoid condensation. If ÄKTA avant is kept in a cold room, cold
cabinet or similar, keep it switched on in order to avoid conden-
sation.

• Avoid overheating. If ÄKTA avant is kept in a cold cabinet and
the cold cabinet is switched off, make sure to switch off ÄKTA
avant and keep the cold cabinet open to avoid overheating.

• Place the computer in room temperature. If the ÄKTA avant
instrument is placed in a cold room, use a cold room compatible
computer or place the computer outside the cold room and use
the Ethernet cable delivered with the instrument to connect to
the computer.

Note: When the instrument is kept in a cold room, it is important to tighten all
tubing connectors, also the inlet manifold connectors. Otherwise air might
get into the flow path.

Note: Make sure that the instrument, buffers and sample have had time to reach
the ambient temperature. When the instrument has reached the ambient
temperature, calibrate all pressure sensors.

Tip: When runs are performed in a cold cabinet, make sure to adjust the target
temperature of the built-in fraction collector temperature control function.
The target temperature is 20°C by default. Settings for the temperature
control function can be edited in the System Settings dialog box of
System Control, or in the Text Instructions pane in Method Editor.
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6 Run a method

About this chapter
This chapter describes how to start up and run a method, and also how to handle the
system after the run.

In this chapter

Section See page

6.1 Before you start 111

6.2 Applying the sample 113

6.3 Start a method run 116

6.4 Monitor the run 122

6.5 After run procedures 124
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6.1 Before you start

Introduction
Before starting a run, it is necessary to read and understand the information in this
section and to perform the checks listed in the next topic.

WARNING

• Always use appropriate Personal Protective Equipment (PPE)
during operation and maintenance of this product.

• Hazardous substances. When using hazardous chemicals,
take all suitable protective measures, such as wearing protec-
tive clothing, glasses and gloves resistant to the substances
used. Follow local and/or national regulations for safe operation
and maintenance of the product.

• High pressure. The product operates under high pressure.
Wear protective glasses and other required Personal Protective
Equipment (PPE) at all times.

Checklist
Make sure that the system is correctly prepared:

• Prepare the system according to the settings in the method to be run.

• Select a suitable column for the application.

• Immerse the buffer inlet tubing in correct buffer vessels.

• Immerse all waste tubing in appropriate waste vessels (consider vessel size, place-
ment and material).

• Verify that no tubing is twisted and that the flow path is free from leakage.

Warnings concerning use of
hazardous substances

WARNING

• Hazardous chemicals during run. When using hazardous
chemicals, run System CIP and Column CIP to flush the entire
system tubing with distilled water, before service and mainte-
nance.

• Hazardous biological agents during run. When using
hazardous biological agents, run System CIP and Column CIP
to flush the entire system tubing with bacteriostatic solution
(e.g. NaOH) followed by a neutral buffer and finally distilled
water, before service and maintenance.
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Hold, pause or stop the run
At the end of a method the run stops automatically. All pumps stop and an acoustic end
signal sounds and End is displayed in the Run Log.

To interrupt a method during a run you may click the Hold, Pause or End buttons in
System Control. A held or paused method run can be resumed by clicking the
Continue button. See the instructions in the following table.

If you want to... then...

temporarily hold the method, with current
flow rate and valve positions sustained

click the Hold button.

temporarily pause the method, and stop all
pumps

click the Pause button.

resume, for example, a held or paused
method run.

click the Continue button.

Note:

An ended method cannot be
continued.

permanently end the run click the End button.

Note: When ending a method run in advance, it is possible to save the partial
result.
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6.2 Applying the sample

Introduction
A number of different sample application techniques are available. The sample can be
applied either directly onto the column using the sample pump, or via a loop. A loop can
be filled either manually or by using the sample pump.

This section describes sample application using a syringe to manually fill a sample loop.

Sample application stages
The two stages of the sample application are described in the following table. For
detailed instructions and information regarding the different sample applications
techniques, see ÄKTA avant User Manual.

Stage Description

Load The sample loop is filled with sample.

Inject The sample is injected onto the column.

How to fill a sample loop

Follow the instructions to fill the sample loop with sample.

Step Action

1 Connect a suitable sample loop to the Injection Valve ports LoopF (fill) and
LoopE (empty).

2 Fill a syringe with sample.
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Step Action

3 Connect the syringe to the Injection Valve port Syr.

4 Load sample into the sample loop. To avoid sample loss due to siphoning,
leave the syringe in the port until the sample has been injected onto the
column during the run.

Tip:

It is recommended to overload the loop to make sure that the loop is
completely filled. Excess of sample will leave the valve through port W1.

Sample application/injection
through a sample loop

A sample loop is manually filled with sample using a syringe connected to the Injection
Valve. During the method run, the sample is automatically injected onto the column.
The loop is emptied and washed out using buffer from the system pumps.

The total buffer volume to be used for emptying and washing the sample loop is set in
the Phase Properties tab of the Sample Application phase in the Empty loop with
box.
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Tip: Empty the sample loop with a buffer volume that exceeds the volume of the
loop. This will ensure that the loop is completely emptied.
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6.3 Start a method run

Introduction
This section describes how to start a run using a previously created method. If Column
Logbook was enabled during installation of the software, registration and selection of
individual columns is possible at method start. For further information on method
creation, please refer to UNICORN Method Manual.

Choose and start a method

The following instructions describe how to open a method and start a run.

Step Action

1 Open the System Control module and click the Open Method Navigator
button.

Result:

The Method Navigator pane opens.

2 Select the method to run, and click the Run button.

Result:

The Start Protocol dialog box opens.

3 Step through the displayed pages in the Start Protocol, add requested
input and make appropriate changes if necessary. Click Next.
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Step Action

4 Click Start on the last page of the Start Protocol.

Result:

• If column logging was chosen at installation of UNICORN and a column
type was selected at method creation, the Select Columns dialog box
opens. Continue with the steps outlined in the next topic.

• If column logging was not chosen at installation of UNICORN and/or no
column type was selected at method creation, the run starts directly.

Register a column and start a run

The following instructions describe how to register a column and start a run.
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Step Action

1 Is the column to be used already registered?

• If No, continue to step 2.

• If Yes, continue to step 5.

2 In the Select Columns dialog box, click New.

Result:

The first New Column dialog box opens.
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Step Action

3 Register the column using the Barcode Scanner 2-D as follows:

• Make sure that the pointer is placed in the first position of the Code box.

• Point the Barcode Scanner 2-D towards the data matrix tag on the
column.

• Press and hold the trigger to create a beam.

• When the scanner beeps, the column ID is registered and displayed in the
dialog box.

• Alternatively, manually enter the column ID, that you find on the column
label, in the dialog box using your keyboard.

• Click Continue.

Result:

The expanded New Column dialog box opens.
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Step Action

4 In the expanded New Column dialog box:

• Enter an column alias in the Alias box (optional).

• Click a chromatography technique on the Technique menu.

• Click a column type on the Column type menu.

• Select the Set medium expiration date check box and click a date on
the menu.

• Click OK.

Tip:

Alias can be used for easy identification of a column.

Result:

The entered information is saved and the dialog box closes.
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Step Action

5 In the Select Columns dialog box:

• Click Enter ID.

• Use the Barcode Scanner 2-D (see step 3) to enter the column ID.

• Alternatively, click Select ID and click the column individual to be used in
the run from the menu.

• Click OK.

Result:

The run starts. All necessary actions occur automatically according to the
method, including ending of the run.
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6.4 Monitor the run

Introduction
You may follow the on-going method run in the System Control module. The current
system status is shown in the System state panel in the Run Data pane. For example,
it may state Run, Wash or Hold. The same information is also shown in the instrument
display.

• Selected curves are shown in the Chromatogram pane.

• All registered actions during the run are displayed in the Run Log pane.

• The current flow path is shown in the Process Picture pane.

For details on the System Control interface, see Section 3.2.2 The System Control
module, on page 38.

Monitor the run
To interrupt a method during a run you may click the Hold, Pause or End buttons in
System Control. A held or paused method run can be resumed by clicking the
Continue button. See the following table.

If you want to... then...

temporarily hold the method, with current flow
rate and valve positions sustained click the  button.

temporarily pause the method, and stop all
pumps click the  button.

resume, for example, a held or paused method
run. click the  button.

Note:

An ended method cannot be
resumed.

permanently end the run

click the  button.

Note: When ending a method run in advance, it is possible to save the partial
result.

Process Picture
The Process Picture displays the current flow path, run parameters and real-time
data from monitors during a run. It also allows manual interactions with the system.

Tubing colors indicate flow path states, as shown in the following illustration and
described in the following table.
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Modules without a fixed place in the system are shown in a panel below the process
picture (modules are called components in the process picture).

Color Indication

Green Open flow path with flow.

Grey Closed flow path or an open path without flow.

Blue Syringe port in loop open for manual injection.

Actions in the Process Picture pane
It is possible to interact with the Process Picture pane.

• To open a related instruction, click the component icon. The example below shows
the pop-up toolbar for the Injection valve icon. Instructions can be given from the
pop-up toolbar of each component icon.

• To display a detailed picture with explanations, for example for a valve, right-click
the component icon and click Detailed picture.
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6.5 After run procedures

Introduction
This section describes how to clean the instrument and columns after a chromato-
graphic run, and how to prepare the system for storage.

The instrument and the columns should be cleaned between the runs. This will prevent,
for example, sample contamination, protein precipitation and column clogging. If the
instrument is not going to be used for a couple of days or longer, the instrument,
columns and the pH flow cell should be filled with storage solution. For further informa-
tion about cleaning and maintenance procedures, see Chapter 7 Maintenance, on page
127.

Tip: To clean and fill the instrument and columns with storage solution, use the
System CIP and Column CIP methods. Either as separate, predefined
methods or as phases included in a chromatographic method.

WARNING

Corrosive chemicals during maintenance. If the system or
column is cleaned with a strong base or acid, flush with water after-
wards and wash with a weak neutral buffer solution in the last step
or phase.

System cleaning
After a method run is completed, perform the following:

• Rinse the instrument with one or several cleaning solution(s) (e.g., NaOH, buffer
solution or distilled water) using the System CIP method.

• If applicable, empty the fraction collector.

• Clean all spills on the instrument and on the bench using a moist tissue.

• Empty the waste vessel.

• Clean the manual injection port of the injection valve, see ÄKTA avant User Manual
for detailed instructions.

• If applicable, clean the pH electrode manually and make sure to leave it in an appro-
priate buffer. See ÄKTA avant User Manual for detailed instructions.

System storage
If the instrument is not going to be used for a couple of days or longer, also perform the
following:

• Fill the system and inlets with storage solution (e.g., 20% ethanol) using the System
CIP method.

Column cleaning
After a method run is completed, perform the following:
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• Clean the column with one or several cleaning solution(s) using the Column CIP
method.

Column storage
If the column is not going to be used for a couple of days or longer, also perform the
following:

• Fill the column with storage solution (e.g., 20% ethanol) using the Column CIP
method.

pH electrode storage
If pH monitoring will not be used for a week or longer, perform one of the following
actions:

• Inject new storage solution into the pH flow cell.

• Replace the pH electrode with the dummy electrode that is installed in the pH valve
on delivery.

In the following situations, in order to increase the lifetime of the pH electrode, use the
By-pass position and store the electrode in storage solution inside the pH flow cell:

• pH monitoring is not needed during the run.

• Organic solutions are used.

• Extremely acidic or extremely basic solutions are used.

For further information on how to prepare the pH electrode for storage, refer to ÄKTA
avant User Manual.

Log off or exit UNICORN
Follow the instructions to log off or exit UNICORN. This can be performed from any of
the UNICORN modules.

If you want to... then...

log off UNICORN on the File menu, click Log off.

Result: All open UNICORN modules close and the Log
On dialog box opens.

exit UNICORN on the File menu, click Exit UNICORN.

Result: All open UNICORN modules close.
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Note: If an edited method or result is open and not saved when you try to exit or
log off UNICORN, you will see a warning. Click Yes to save, No to exit
without saving, or Cancel to stay logged on.

Shut down the instrument
Switch off the instrument by pressing the Power switch to the O position.
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7 Maintenance

About this chapter
Regular maintenance is essential for reliable function and results. This chapter
provides schedules for preventive maintenance that should be performed by the user
of the ÄKTA avant instrument.

Instructions for replacing pump parts and cleaning pump head check valves are
included in this chapter.

Refer to the ÄKTA avant User Manual for detailed instructions for maintenance and
replacement of parts.

WARNING

Always use appropriate Personal Protective Equipment (PPE)
during operation and maintenance of this product.

In this chapter

Section See page

7.1 Maintenance program 128

7.2 Replace pump piston seal, O-rings, and rinse membrane of
Pump P9 or Pump P9H

130

7.3 Replace pump piston seal, O-ring, and rinse membrane of
Pump P9-S

139

7.4 Replace pump pistons 147

7.5 Clean pump head check valves 148

7.6 Cleaning before planned service 151

7 Maintenance
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7.1 Maintenance program

Introduction
An overview of the preventive maintenance to be performed on the ÄKTA avant instru-
ment is outlined in the following list. See ÄKTA avant User Manual for detailed informa-
tion about the maintenance procedures.

Maintenance is divided into:

• Daily maintenance

• Weekly maintenance

• Monthly maintenance

• Bi-annual maintenance

• Maintenance when required

WARNING

Electrical shock hazard. All repairs should be done by service
personnel authorized by Cytiva. Do not open any covers or replace
parts unless specifically stated in the user documentation.

Periodic maintenance program
The following periodic maintenance should be performed by the user of the ÄKTA
avant instrument.

Interval Maintenance action

Daily Calibrate the pH monitor

Weekly Change pump rinsing solution

Weekly Replace inline filter in the mixer

Weekly Clean the fraction collector

Monthly Check the flow restrictor

Bi-annual Clean the UV flow cell

Bi-annual Replace the pH electrode

Maintenance when required
The following maintenance should be performed by the user of the ÄKTA avant instru-
ment when required. Refer to the ÄKTA avant User Manual for detailed instructions.

7 Maintenance
7.1 Maintenance program
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Maintenance action

Clean the instrument externally

Run System CIP (System cleaning-in-place)

Run Column CIP (Column cleaning-in-place)

Clean the fraction collector

Replace tubing and connectors

Storage of pH electrode

Clean the pH electrode

Clean the conductivity flow cell

Calibrate the conductivity monitor

Calibrate the UV monitor

Calibrate pressure monitors

Replace the mixer

Replace O-ring in mixer

Replace the UV flow cell

Replace the flow restrictor

Replace inlet filters

Wipe off excess oil from pump heads

Clean the check valves. See Section 7.5 Clean pump head check
valves, on page 148

Replace check valves

Replace pump piston seal, O-rings, and rinse membrane. See 
Section 7.2 Replace pump piston seal, O-rings, and rinse
membrane of Pump P9 or Pump P9H, on page 130 and Section 7.3
Replace pump piston seal, O-ring, and rinse membrane of Pump
P9-S, on page 139.

Replace pump pistons. See Section 7.4 Replace pump pistons, on
page 147.

Replace pump rinsing system tubing

Replace valve modules

7 Maintenance
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7.2 Replace pump piston seal, O-rings, and rinse
membrane of Pump P9 or Pump P9H

Introduction
Follow the instructions to replace the O-rings, piston seal, and rinse membrane of
pumps P9, P9H A, P9H B, or P9H S.

Note: Always replace the O-rings, piston seals, and rinse membranes of both
pump heads of a pump at the same time.

Tip: A sign of internal leakage is that the pump rinsing solution volume starts to
increase.

NOTICE

• Do not disassemble the pump head unless there is good reason
to believe that there is an internal leakage. A sign of leakage is
increasing pump rinsing solution volume. Always make sure
that sufficient spare components are available before
attempting to replace a spare part.

• Replacing spare parts. Read the instructions carefully. For
example, some individual parts of the pump head can be assem-
bled incorrectly. Check the orientation of each part before
continuing with the next instruction.

Maintenance interval
Replace the O-rings, piston seals, and rinse membranes the pumps P9, P9H A, P9H B,
and P9H S if they are damaged. After replacement, perform a run to break in the new
piston seals.

NOTICE

Advanced maintenance. Read the instruction carefully before
disassembly of the pump head.

Required material
The following materials are required:

• Adjustable wrench

• For Pump P9: Star screwdriver, T20

• For Pump P9H: Star screwdriver, T10 and T20

• Ultrasonic bath

• Ethanol, 20%

• For Pump P9: Tubing giving a back pressure of 6 to 8 MPa (60 to 80 bar).

7 Maintenance
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• For Pump P9H: Tubing giving a back pressure of 2 to 3 MPa (20 to 30 bar)

• For Pump P9: P9 Seal kit, 25 ml

• For Pump P9H: P9H Seal kit, 150 ml

Illustrations
The illustrations below show the parts of the pump heads of the pumps P9 and P9H.

Pump P9

1 2 3 4 5 6 7

12

98 10

11

13

Pump P9H

1 2 3 4 5 6 7

12

98 10

11

13

7 Maintenance
7.2 Replace pump piston seal, O-rings, and rinse membrane of Pump P9 or Pump P9H

ÄKTA avant Operating Instructions 29101556 AC 131



Part Description Part Description

1 Piston 7 Piston seal

2 Return spring 8 Outlet check valve

3 Pump membrane housing 9 O-ring

4 Star screws 10 Purge valve

5 O-ring 11 Star screws

6 Support washer 12 Inlet check valve

13 Star screws

Disassemble the pump head

Step Action

1 Make sure that no run is in progress on the instrument.

2 Disconnect the tubing from the pump head, and disconnect the pump inlet
tubing.

3 Unscrew the two white plastic screws located below each pump head by
hand. Pull the plastic connectors to the sides to release the inlet manifold.

4 Disconnect the tubing of the pump piston rinsing system.

7 Maintenance
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Step Action

5 Unscrew the two screws of the front section of the pump head using a star
screwdriver T20, and pull off the front section.

6 Place the front section of the pump head face down on the bench. For Pump
P9, unscrew the two screws of the support washer using a star screwdriver,
T20. For Pump P9H, unscrew the four screws of the support washer using a
star screwdriver, T10. Discard the O-ring (1) on the support washer, and the
discard the piston seal (2) located in the front section of the pump head.

Note:

Be careful not to scratch the metal surfaces.

Pump P9

2 1

Pump P9H

2
1
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Step Action

7 Unscrew one of the two screws securing the pump membrane housing using
a star screwdriver, T20. Unscrew the second screw, and at the same time
push firmly on the front of the pump membrane housing to compensate for
the pressure of the piston return spring.

8 Carefully pull off the pump membrane housing together with the piston and
return spring.

9 Inspect the piston and return spring for signs of damage. If damaged,
discard the piston and return spring and use a new piston and return spring
when assembling the pump head.

10 Clean the pump head and pump membrane housing in an ultrasonic bath. If
there are particles on any surfaces, the check valves should be removed and
cleaned separately, see Section 7.5 Clean pump head check valves, on page
148.
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Replace O-rings, piston seal and
pump membrane housing

Step Action

1 Unscrew the purge valve of the pump head. Replace the O-ring on the purge
valve with a new O-ring, , and screw the purge valve back into the pump
head.

Note:

Always use Lubricant 56686700 when exchanging the O-ring 3 x 1 mm.

2 Wet a new seal with 20% ethanol. Place the new seal in the hole in the front
section of the pump head and press it into position.

Pump P9 Pump P9H
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Step Action

3 Place the support washer on top of the new seal in the front section of the
pump head. Screw the two or four screws of the support washer. Make sure
to tighten the screws fully.

Pump P9 Pump P9H

4 Wet a new O-ring, 21.4 x 1.6 mm, with 20% ethanol. Fit the O-ring around the
support washer.

Pump P9 Pump P9H

Assemble the pump head

Make sure to assemble the pump head correctly. Refer to Illustrations on page 131.
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Step Action

1 Insert the piston into the return spring. Insert piston and return spring into
hole in the pump module.

Note:

Do no touch the ceramic or glass part of the pump piston.

2 Wet the membrane in the hole with 20% ethanol before mounting.

3 Place the pump membrane housing onto the locating pins on the front of the
pump module.

4 Screw one of the two screws securing the pump membrane housing using a
star screwdriver, T20. Push firmly on the front of the pump membrane
housing to compensate for the pressure of the piston and then screw the
second screw.

5 Make sure that the new seal is wetted with 20% ethanol and then tighten
both screws fully.

6 Reconnect the tubing of the pump piston rinsing system.

7 Reconnect the inlet manifold.

8 Reconnect the tubing to the pump head, and reconnect the pump inlet
tubing.

Break in the new pump piston seal

Follow the instruction below to break in the new pump piston seal of Pump P9 or P9H.

Step Action

1 Fill a buffer vessel with 20% ethanol in water. Immerse the inlet tubing, for
example A1 for System Pump A, B1 for System Pump B, or S1 for the Sample
Pump in the buffer vessel. Place the buffer vessel on the buffer tray.

2 Prime the inlets and purge the pump, see Section 4.5.1 Prime buffer inlets
and purge system pumps, on page 70.

3 • For Pump P9: Connect the reference capillary Ref 2 (or an equivalent
capillary that gives a backpressure of 6 to 8 MPa [60 to 80 bar]) to one of
the column positions of the column valve (e.g., ports 1A and 1B).

• For Pump P9H: Connect the reference capillary Ref 1 (or an equivalent
capillary that gives a backpressure of 2 to 3 MPa [20 to 30 bar] to one of
the column positions of the column valve (e.g., ports 1A and 1B).

4 Immerse the waste tubing in the buffer vessel to recirculate the liquid.
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Step Action

5 • If breaking in a pump piston seal of a system pump, follow the instruction
below:

In the Manual instructions dialog box:

- Select Flow path →Column valve, and select the position of the
capillary connected to the column valve. Click Insert.

- Select Flow path →Inlet A (for System Pump A) or Flow path →Inlet
B (for System Pump B) and select a Position. Click Insert.

- Select Pumps and Pressures →Gradient and set Target to 0% B (for
System Pump A) or 100% B (for system pump B).

- For PumpP9: Select Pumps and Pressures →System flow and set
the Flow rate to 5.0 ml/min. Click Insert.

For PumpP9H: Select Pumps and Pressures →System flow and set
the Flow rate to 25.0 ml/min. Click Insert.

- Click Execute.

Result:

A system flow starts.

• If breaking in a pump piston seal of a sample pump, follow the instruction
below:

In the Manual instructions dialog box:

- Select Flow path →Column valve, and select the position of the
capillary connected to the column valve. Click Insert.

- Select Flow path →Sample inlet and select a Position. Click Insert.

- Select Flow path →Injection valve and click Direct inject on the
Position menu. Click Insert.

- Select Pumps and Pressures →Sample flow and set the Flow rate
to 25.0 ml/min. Click Insert.

- Click Execute.

Result:

A sample flow starts.

6 Run the flow for 2 hours.

7 Discard the used buffer.
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7.3 Replace pump piston seal, O-ring, and rinse membrane
of Pump P9-S

Introduction
Follow the instructions to replace the O-ring, piston seal, and rinse membrane of Pump
P9-S.

Note: Always replace the O-rings, piston seals, and rinse membranes of both
pump heads of a pump at the same time.

NOTICE

• Do not disassemble the pump head unless there is good reason
to believe that there is an internal leakage. A sign of leakage is
increasing pump rinsing solution volume. Always make sure
that sufficient spare components are available before
attempting to replace a spare part.

• Replacing spare parts. Read the instructions carefully. For
example, some individual parts of the pump head can be assem-
bled incorrectly. Check the orientation of each part before
continuing with the next instruction.

Maintenance interval
Replace the O-ring, piston seal, and rinse membrane of Pump P9-S if they are
damaged. After replacement, perform a run to break in the new piston seal.

NOTICE

Advanced maintenance. Read the instruction carefully before
disassembly of the pump head.

Required material
The following materials are required:

• Adjustable wrench

• Star screwdriver, T20

• Cross-headed screwdriver

• Hex wrench

• Ultrasonic bath

• Ethanol, 20%

• Reference capillary Ref 1

• P9-S Seal kit, 65 ml
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Illustration
The illustration below shows the parts of the pump heads of Pump P9-S.

1 2 3 4 5

10

87 9

6

Part Description Part Description

1 Piston 6 Piston seal

2 Return spring 7 Outlet check valve

3 Drain plate 8 O-ring

4 Rinse membrane 9 Purge valve

5 Rinse chamber 10 Inlet check valve

Disassemble the pump head

Step Action

1 Make sure that no run is in progress on the instrument.

2 Disconnect the tubing from the pump head, and disconnect the pump inlet
tubing.
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Step Action

3 Unscrew the two white plastic screws located below each pump head by
hand. Pull the plastic connectors to the sides to release the inlet manifold.

4 Disconnect the tubing of the pump piston rinsing system.

5 Unscrew one of the two screws of the pump head using a hex wrench.
Unscrew the second screw, and at the same time push firmly on the front of
the rinse chamber to compensate for the pressure of the piston return
spring.
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Step Action

6 Place the pump head face down on the bench. Pull out the piston together
with the return spring.

7 Inspect the piston and return spring for sign of damage. If damaged, discard
the piston and return spring and use a new piston and return spring when
assembling the pump head.

8 Unscrew the two screws securing the drain plate and the rinse chamber. Lift
off the drain plate, and discard the membrane located between the drain
plate and the rinse chamber.
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Step Action

9 Lift off the rinse chamber. Gently pull off the piston seal. Discard the used
seal.

10 Clean the pump head, rinse chamber and drain plate in an ultrasonic bath. If
there are particles on any surfaces, the check valves should be removed and
cleaned separately, see Section 7.5 Clean pump head check valves, on page
148.

Replace O-ring, piston seal, and rinse
membrane

Step Action

1 Unscrew the purge valve of the pump head. Replace the O-ring on the purge
valve with a new O-ring, 3x1 mm, and screw the purge valve back into the
pump head.

Note:

Always use Lubricant 56686700 when exchanging the O-ring 3 x 1 mm.
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Step Action

2 Wet a new seal with 20% ethanol. Place the new seal in the hole in the front
section of the pump head and press it into position.

3 With the pump head facing downwards on the bench, place the rinse
chamber onto the front section of the pump head with the rinse ports in line
with the check valves. The conical depression in the rinse chamber shall be
facing upwards. Wet a new membrane with 20% ethanol, and place the
membrane into the rinse chamber with the conical face upwards.

Assemble the pump head

Make sure to assemble the pump head correctly. Refer to Illustrations on page 131.

Step Action

1 Place the drain plate on top of the assembly. Screw the two screws through
the drain plate and the rinse chamber using a cross-headed screwdriver.

2 Wipe clean the piston and remove all finger prints. Wet the piston with 20%
ethanol, and insert the piston into the return spring. With the pump head
facing downwards on the bench, insert the piston into the pump head by
pushing it gently but firmly vertically downwards into the seal.
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Step Action

3 Place the complete pump head over the locating pins on the front panel of
the sample pump module. Turn the pump head so that the text UP on the
drain plate is facing upwards. Push firmly on the front of the pump head, and
at the same time screw one of the screws to fasten the pump head onto the
front of the module using a hex wrench. Screw the second screw of the pump
head. Make sure to tighten both screws fully.

4 Reconnect the tubing of the pump piston rinsing system.

5 Reconnect the inlet manifold.

6 Reconnect the tubing to the pump head, and reconnect the pump inlet
tubing.

7 Break in the new pump piston seal, see instruction below.

Break in the new pump piston seal

Follow the instruction to break in the new pump piston seal of Pump P9-S .

Step Action

1 Fill a buffer vessel with 20% ethanol in water. Immerse a piece of sample
inlet tubing, for example S1, in the buffer vessel. Place the buffer vessel on
the buffer tray.

2 Prime the inlets and purge the pump, see Section 4.5.2 Prime sample inlets
and purge Sample Pump, on page 77.

3 Connect the reference capillary Ref 1 (or an equivalent capillary that gives a
backpressure of 2 to 3 MPa [20 to 30 bar]) to one of the column positions of
the column valve (e.g., ports 1A and 1B).

4 Immerse the waste tubing in the buffer vessel to recirculate the liquid.

5 In the Manual instructions dialog:

• Select Flow path →Column position, and select the Position of the
capillary connected to the column valve. Click Insert.

• Select Flow path →Sample inlet and select a Position. Click Insert.

• Select Flow path →Injection valve and click Direct inject on the Posi-
tion menu. Click Insert.

• Select Pumps →Sample flow and set the Flow rate to 25.0 ml/min. Click
Insert.

• Click Execute.

Result:

A sample flow of 25.0 ml/min starts.
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Step Action

6 Run the flow for 2 hours.

7 Discard the used buffer.
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7.4 Replace pump pistons

Introduction
Follow the instructions to replace the pump pistons of the pumps P9, P9H and P9-S.

Note: Always replace the O-rings, piston seals, and rinse membranes of both
pump heads of a pump at the same time.

NOTICE

• Do not disassemble the pump head unless there is good reason
to believe that there is an internal leakage. A sign of leakage is
increasing pump rinsing solution volume. Always make sure
that sufficient spare components are available before
attempting to replace a spare part.

• Replacing spare parts. Read the instructions carefully. For
example, some individual parts of the pump head can be assem-
bled incorrectly. Check the orientation of each part before
continuing with the next instruction.

Maintenance interval
Replace the pump pistons if they are damaged.

Required material
The following materials are required:

• Adjustable wrench

• Star screwdriver, T20

• Piston kit

Replace pump pistons of Pump P9
and P9H

If a damaged piston has been in operation, the piston seal will be destroyed and should
also be replaced. To replace the piston and the seal of a system pump, see Section 7.2
Replace pump piston seal, O-rings, and rinse membrane of Pump P9 or Pump P9H, on
page 130.

Replace pump pistons of Pump P9-S
If a damaged piston has been in operation, the piston seal will be destroyed and should
also be replaced. To replace the piston and the seal of Pump P9-S, see Section 7.3
Replace pump piston seal, O-ring, and rinse membrane of Pump P9-S, on page 139.
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7.5 Clean pump head check valves

Introduction
Clean the check valves when required, for example if particles like dust or salt crystals
in the check valve cause irregular or low flow. The cleaning procedure is the same for
the system pumps and the sample pump.

Required material
The following materials are required:

• Adjustable wrench

• 100% Methanol

• Distilled water

• Ultrasonic bath

Instruction

Follow the instructions to remove and clean the pump head check valves.

Step Action

1 Before taking the check valve apart, always try to clean the check valves by
priming the pump heads first with distilled water, then with 100% Methanol
and then with distilled water again.

2 Switch off the instrument.

3 Disconnect the tubing from the pump head and disconnect the pump inlet
tubing. Disconnect the tubing of the pump rinsing system.

4 Unscrew the purge valve by turning it counter-clockwise, and lift off the
metal ring.
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Step Action

5 Unscrew the plastic nut of the upper check valve using an adjustable wrench,
and gently lift off the upper check valve.

6 Unscrew the two white plastic screws located below each pump head. Pull
the plastic connectors to the sides to release the inlet manifold.

7 Unscrew the lower check valve using an adjustable wrench.
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Step Action

8
WARNING

Hazardous substances. When using hazardous chemi-
cals, take all suitable protective measures, such as
wearing protective clothing, glasses and gloves resistant
to the substances used. Follow local and/or national
regulations for safe operation and maintenance of the
product.

Immerse the valves completely in methanol and place them in an ultrasonic
bath for a few minutes. Repeat the ultrasonic bath with deionized water.

9 Refit the check valves.

10 Tighten the nut until fully finger-tight and then use the adjustable wrench to
tighten a further 90 degrees.

11 Refit the inlet manifold and reconnect the tubing to the pump head.
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7.6 Cleaning before planned service

Cleaning before planned
maintenance/service

To ensure the protection and safety of service personnel, all equipment and work areas
must be clean and free of any hazardous contaminants before a Service Engineer
starts maintenance work.

Please complete the checklist in the On Site Service Health and Safety Declaration
Form or the Health and Safety Declaration Form for Product Return or Servicing,
depending on whether the instrument is going to be serviced on site or returned for
service, respectively.

Health and safety declaration forms
Health and safety declaration forms are available for copying or printing in the Refer-
ence information chapter of this manual, or on digital media supplied with the user
documentation.
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8 Reference Information

About this chapter
This chapter lists the technical specifications of the ÄKTA avant instrument. The
chapter also includes a chemical resistance guide. See also ÄKTA avant 25 Product
Documentation and ÄKTA avant 150 Product Documentation for detailed technical
specifications.

In this chapter

Section See page

8.1 System specifications 153

8.2 Chemical resistance guide 155

8.3 Recycling information 161

8.4 Regulatory information 162

8.5 Ordering information 171

8.6 Health and Safety Declaration Form 181

8 Reference Information
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8.1 System specifications

Technical specifications

Parameter Data

System configuration Benchtop system, external computer

Control system UNICORN™ 6.3.2 or later version

Connection between PC and instrument Ethernet

Dimensions (Length x Depth x Height) 860 x 710 x 660 mm

Weight (excluding computer) 116 kg

Power supply 100-240 VAC, 50-60 Hz

Power consumption 800 VA

Enclosure protective class IP 21, wet side IP 22

Tubing and connectors ÄKTA avant 25:

• Inlet: FEP tubing, inner diameter (i.d.) 1.6 mm,
Tubing connector 5/16″ + Ferrule (yellow),
1/8″

• Pump to Injection valve: PEEK tubing, i.d.
0.75 mm, Fingertight connector, 1/16″

• After Injection valve: PEEK tubing, i.d.
0.50 mm, Fingertight connector, 1/16″

• Outlet and waste: ETFE tubing, i.d. 1.0 mm,
Fingertight connector, 1/16″

ÄKTA avant 150:

• Inlet: FEP tubing, i.d. 2.9 mm, Tubing
connector 5/16″ + Ferrule (blue), 3/16″

• After pumps: PEEK tubing, 1.0 mm i.d., Finger-
tight connector, 1/16″

• Outlet: FEP o.d.1/8″, i.d. 1.6 mm, Tubing
connector 5/16″ + Ferrule (yellow), 1/8″

• Waste: ETFE tubing, i.d. 1.0 mm, Fingertight
connector, 1/16″
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Enviromental requirements

Parameter Data

Storage and transport temperature
range

-25°C to 60°C

Chemical environment See Section 8.2 Chemical resistance
guide, on page 155.

Operating temperature range 4°C to 35°C

Relative humidity 20% to 95%, noncondensing

Equipment noise level

Equipment Acoustic noise
level

ÄKTA avant instrument < 70 dBA
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8.2 Chemical resistance guide

Introduction
This section provides general information about biocompatibilty and detailed informa-
tion about chemical resistance of the ÄKTA avant instrument.

In this section

Section See page

8.2.1 General information about biocompatibility and chemical
resistance

156

8.2.2 Chemical resistance specifications 157
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8.2.1 General information about biocompatibility and
chemical resistance

Biocompatibility
The ÄKTA avant instrument is designed for maximum biocompatibility, with biochemi-
cally inert flow paths constructed mainly from titanium, PEEK and highly resistant fluo-
ropolymers and fluoroelastomers. Titanium is used as far as possible to minimize
contribution of potentially deactivating metal ions such as iron, nickel and chromium.
There is no standard stainless steel in the flow path. Plastics and rubber materials are
selected to avoid leakage of monomers, plasticizers or other additives.

Cleaning chemicals
Strong cleaning works well with 2 M sodium hydroxide, 70% acetic acid or the alcohols
methanol, ethanol and isopropyl alcohol. Complete system cleaning using 1 M hydro-
chloric acid should be avoided in order to not damage the pressure sensors. If you are
cleaning separation media using 1 M hydrochloric acid, use loop injections of the acid
and make sure that the column is not mounted on the Column Valve V9-C. The Column
Valve V9-C contains a pressure sensor which can be damaged by 1 M hydrochloric
acid.

Long time use of 0.2 M HCl connected to the Quaternary Valve Q9 as part of a
BufferPro recipe is acceptable. The solution becomes diluted further down in the
system.

If sodium hypochlorite is used as sanitizing agent instead of 2 M sodium hydroxide, use
a concentration up to 10%.

Organic solvents
Reversed phase chromatography of proteins works well with 100% acetonitrile and
additives trifluoroacetic acid (TFA) up to 0.2% or formic acid up to 5%.

Strong organic solvents like ethyl acetate, 100% acetone or chlorinated organic
solvents should be avoided. These might cause swelling of plastic material and reduce
the pressure tolerance of PEEK tubing. For this reason, flash chromatography and
straight (“normal”) phase chromatography is generally not recommended on the
system.

Assumptions made
The ratings are based on the following assumptions:

• Synergy effects of chemical mixtures have not been taken into account.

• Room temperature and limited overpressure is assumed.

Note: Chemical influences are time and pressure dependent. Unless otherwise
stated, all concentrations are 100%.

8 Reference Information
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8.2.2 Chemical resistance specifications

Introduction
This section provides detailed information about chemical resistance of the ÄKTA
avant instrument to some of the most commonly used chemicals in liquid chromatog-
raphy. Regarding exposure to solutions not covered by this information, contact your
Cytiva representative for recommendations.

Note: A user can be exposed to large volumes of chemical substances over a long
time period. Material Safety Data Sheets (MSDS) provide the user with infor-
mation regarding characteristics, human and environmental risks and
preventive measures. Make sure that you have the MSDS available from
your chemical distributor and/or databases on the internet.

Aqueous buffers
The specified aqueous buffers are suitable for continuous use.

Chemical Concen-
tration

CAS no/EC no

Aqueous buffers

pH 2-12

N/A N/A

Strong chemicals and salts for CIP
The following chemicals are suitable for up to 2 h contact time at room temperature.

Chemical Concen-
tration

CAS no/EC no

Acetic acid 70% 75-05-8/ 200-835-2

Decon™ 90 10% N/A

Ethanol 100% 75-08-1/ 200-837-3

Methanol 100% 67-56-1/ 200-659-6

Hydrochloric acid1 0.1 M 7647-01-0/ 231-595-7

Isopropanol 100% 67-63-0/ 200-661-7

Sodium hydroxide 2 M 1310-73-2/ 215-185-5

Sodium hydroxide/ethanol 1 M/40% N/A

Sodium chloride 4 M 7647-14-5/ 231-598-3
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Chemical Concen-
tration

CAS no/EC no

Sodium hypochlorite 10% 7681-52-9/231-668-3

1 If hydrochloric acid, HCl, is used as a cleaning agent when columns are connected to the system, the
HCl concentration should not exceed 0.1 M in the pressure sensors. Remember that the ÄKTA avant
system has pressure sensors in the column valve V9-C.

For other parts of the system up to 1 M HCl is acceptable for short periods of use. See Cleaning chemi-
cals on page 156

Solubilization and denaturing agents
The following chemicals are suitable for continuous use, as additives in separation and
purification methods.

Chemical Concen-
tration

CAS no/EC no

Guanidinium hydrochloride 6 M 50-01-1/ 200-002-3

Sodium dodecyl sulfate
(SDS)

1% 151-21-3/ 205-788-1

Tween™ 20 1% 9005-64-5/ 500-018-3

Urea 8 M 57-13-6/ 200-315-5

Chemicals used in reversed phase
chromatography (RPC)

The following chemicals are suitable for continuous use.

Chemical Concen-
tration

CAS no/EC no

Acetonitrile1 100% 75-05-8/ 200-835-2

Acetonitrile/Tetrahydro-
furan1

85%/15% 109-99-9/ 203-726-8

Acetonitrile/water/
Trifluoroacetic acid (TFA)2

Max 0.2%
TFA

N/A

Ethanol 100% 75-08-1/ 200-837-3

Isopropanol 100% 67-63-0/ 200-661-7

Methanol 100% 74-93-1/ 200-659-6

8 Reference Information
8.2 Chemical resistance guide

8.2.2 Chemical resistance specifications

158  ÄKTA avant Operating Instructions 29101556 AC



Chemical Concen-
tration

CAS no/EC no

Water/organic mobile
phase/formic acid

Max 5%
formic acid

N/A

1 Organic solvents can penetrate weaknesses in PEEK tubing walls more easily than water based
buffers. Special care should therefore be taken with prolonged use of organic solvents close to pres-
sure limits.

Note: Quaternary valve is not resistant.

Depending on pressure, tubing between pump head and pressure monitor needs to be changed. See
ÄKTA avant User Manual for more information.

2 Mobile phase system.

Note: It is recommended to replace the mixer sealing ring with the highly resistant
O-ring (product code 29011326) if the system is to be exposed to organic
solvents or high concentrations of organic acids, such as acetic acid and
formic acid, for a longer period of time.

Salts and additives for hydrophobic
interaction chromatography (HIC)

The following chemicals are suitable for continuous use.

Chemical Concen-
tration

CAS no/EC no

Ammonium chloride 2 M 12125-02-9/ 235-186-4

Ammonium sulfate 3 M 7783-20-2/ 231-984-1

Ethylene glycol 50% 107-21-1/ 203-473-3

Glycerol 50% 56-81-5/ 200-289-5

Reducing agents and other additives
The following chemicals are suitable for continuous use.

Chemical Concen-
tration

CAS no/EC no

Arginine 2 M 74-79-3 / 200-811-1

Benzyl alcohol 2% 100-51-6 / 202-859-9

Dithioerythritol (DTE) 100 mM 3483-12-3 / 222-468-7

Dithiothreitol (DTT) 100 mM 6862-68-8 / 229-998-8

Ethylenediaminetetraacetic
acid (EDTA)

100 mM 60-00-4 / 200-449-4
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Chemical Concen-
tration

CAS no/EC no

Mercaptoethanol 20 mM 37482-11-4 / 253-523-3

Potassium chloride 4 M 7447-40-7 / 231-211-8

Other substances
The following chemicals are suitable for continuous use.

Chemical Concen-
tration

CAS no/EC no

Acetone 10% 67-64-1/ 200-662-2

Ammonia 30% 7664-41-7/ 231-635-3

Dimethyl sulphoxide
(DMSO)

5% 67-68-5/ 200-664-3

Ethanol for long-term
storage

20% 75-08-1/ 200-837-3

Phosphoric acid 0.1 M 7664-38-2/ 231-633-2
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8.3 Recycling information

Introduction
This section contains information about the decommisioning of ÄKTA avant.

Decontamination
The product must be decontaminated before decommissioning. All local regulations
must be followed with regard to scrapping of the equipment.

Disposal of the product
When taking the product out of service, the different materials must be separated and
recycled according to national and local environmental regulations.

CAUTION

Always use appropriate personal protective equipment when
decommissioning the equipment.

Disposal of electrical components
Waste comprising electrical and electronic equipment must not be disposed of as
unsorted municipal waste and must be collected separately. Please contact an author-
ized representative of the manufacturer for information concerning the decommis-
sioning of equipment.
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8.4 Regulatory information

Introduction
This section lists the regulations and standards that apply to ÄKTA avant.

In this section

Section See page

8.4.1 Contact information 163

8.4.2 European Union and European Economic Area 164

8.4.3 Eurasian Economic Union
Евразийский экономический союз

165

8.4.4 Regulations for North America 167

8.4.5 Regulatory statements 168

8.4.6 Declaration of Hazardous Substances (DoHS) 169

8 Reference Information
8.4 Regulatory information
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8.4.1 Contact information

Contact information for support
To find local contact information for support and sending troubleshooting reports, visit 
cytiva.com/contact.

Manufacturing information
The table below summarizes the required manufacturing information.

Requirement Information

Name and address of manufacturer Cytiva Sweden AB

Björkgatan 30

SE 751 84 Uppsala

Sweden

Telephone number of manufacturer + 46 771 400 600

8 Reference Information
8.4 Regulatory information

8.4.1 Contact information

ÄKTA avant Operating Instructions 29101556 AC 163

http://www.cytiva.com/contact


8.4.2 European Union and European Economic Area

Introduction
This section describes regulatory information for the European Union and European
Economic Area that applies to the equipment.

Conformity with EU Directives
See the EU Declaration of Conformity for the directives and regulations that apply for
the CE marking.

If not included with the product, a copy of the EU Declaration of Conformity is available
on request.

CE marking

The CE marking and the corresponding EU Declaration of Conformity is valid for the
instrument when it is:

• used according to the Operating Instructions or user manuals, and

• used in the same state as it was delivered, except for alterations described in the
Operating Instructions or user manuals.
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8.4.3 Eurasian Economic Union
Евразийский экономический союз

This section describes the information that applies to the product in the Eurasian
Economic Union (the Russian Federation, the Republic of Armenia, the Republic of
Belarus, the Republic of Kazakhstan, and the Kyrgyz Republic).

Introduction
This section provides information in accordance with the requirements of the Tech-
nical Regulations of the Customs Union and (or) the Eurasian Economic Union.

Введение
В данном разделе приведена информация согласно требованиям Технических
регламентов Таможенного союза и (или) Евразийского экономического союза.

Manufacturer and importer
information

The following table provides summary information about the manufacturer and
importer, in accordance with the requirements of the Technical Regulations of the
Customs Union and (or) the Eurasian Economic Union.

Requirement Information

Name, address and telephone
number of manufacturer

See Manufacturing information

Importer and/or company for
obtaining information about
importer

LLC Global Life Sciences Solutions Rus

Russian Federation, 123112

Presnenskaya nab., 10, fl. 12, pr. III, room 6

Telephone: + 7 495 739 6931

Fax nr: + 7 495 739 6932

E-mail: rucis@cytiva.com

Информация о производителе и
импортере

В следующей таблице приводится сводная информация о производителе и
импортере, согласно требованиям Технических регламентов Таможенного союза
и (или) Евразийского экономического союза.

Требование Информация

Наименование, адрес и номер
телефона производителя

См. Информацию об изготовлении
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Требование Информация

Импортер и/или лицо для
получения информации об
импортере

ООО "Глобал Лайф Сайэнсиз Солюшнз
Рус"

Российская Федерация, 123112

Пресненская наб., д. 10, эт. 12, пом. III,
ком. 6

Телефон: + 7 495 739 6931

Факс: + 7 495 739 6932

Адрес электронной почты: 
rucis@cytiva.com

Description of symbol on the system
label
Описание обозначения на этикетке
системы

This Eurasian compliance mark indicates that the product is
approved for use on the markets of the Member States of the
Customs Union of the Eurasian Economic Union

Данный знак о Евразийском соответствии указывает, что
изделие одобрено для использования на рынках
государств-членов Таможенного союза Евразийского
экономического союза
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8.4.4 Regulations for North America

Introduction
This section describes the information that applies to the product in the USA and
Canada.

FCC compliance
This device complies with part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) This device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may cause unde-
sired operation.

Note: The user is cautioned that any changes or modifications not expressly
approved by Cytiva could void the user’s authority to operate the equip-
ment.

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in
a commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference in which case the
user will be required to correct the interference at his own expense.
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8.4.5 Regulatory statements

Introduction
This section shows regulatory statements that apply to regional requirements.

EMC emission, CISPR 11: Group 1,
Class A statement

NOTICE

This equipment is not intended for use in residential environments
and may not provide adequate protection to radio reception in
such environments.

South Korea
Regulatory information to comply with the Korean technical regulations.

NOTICE

Class A equipment (equipment for business use).

This equipment has been evaluated for its suitability for use in a
business environment.

When used in a residential environment, there is a concern of radio
interference.

주의
A급 기기 (업무용 방송통신 기자재)

이 기기는 업무용환경에서 사용할 목적으로 적합성평가를 받
은 기기
로서 가정용 환경에서 사용하는 경우 전파간섭의 우려가 있습
니다.
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8.4.6 Declaration of Hazardous Substances (DoHS)
根据 SJ/T11364-2014《电子电气产品有害物质限制使用标识要求》特提供如下
有关污染控制方面的信息。
The following product pollution control information is provided according to SJ/
T11364-2014 Marking for Restriction of Hazardous Substances caused by electrical
and electronic products.

电子信息产品污染控制标志说明
Explanation of Pollution Control
Label

该标志表明本产品含有超过中国标准 GB/T 26572 《电子电气产品中限用物质的限量要
求 》中限量的有害物质。标志中的数字为本产品的环保使用期，表明本产品在正常使用
的条件下，有毒有害物质不会发生外泄或突变，用户使用本产品不会对环境造成严重污
染或对其人身、财产造成严重损害的期限。单位为年。
为保证所申明的环保使用期限，应按产品手册中所规定的环境条件和方法进行正常使
用，并严格遵守产品维修手册中规定的定期维修和保养要求。
产品中的消耗件和某些零部件可能有其单独的环保使用期限标志，并且其环保使用期限
有可能比整个产品本身的环保使用期限短。应到期按产品维修程序更换那些消耗件和零
部件，以保证所申明的整个产品的环保使用期限。
本产品在使用寿命结束时不可作为普通生活垃圾处理，应被单独收集妥善处理。
This symbol indicates the product contains hazardous materials in excess of the limits estab-
lished by the Chinese standard GB/T 26572 Requirements of concentration limits for certain
restricted substances in electrical and electronic products. The number in the symbol is the Envi-
ronment-friendly Use Period (EFUP), which indicates the period during which the hazardous
substances contained in electrical and electronic products will not leak or mutate under normal
operating conditions so that the use of such electrical and electronic products will not result in
any severe environmental pollution, any bodily injury or damage to any assets. The unit of the
period is “Year”.

In order to maintain the declared EFUP, the product shall be operated normally according to the
instructions and environmental conditions as defined in the product manual, and periodic main-
tenance schedules specified in Product Maintenance Procedures shall be followed strictly.

Consumables or certain parts may have their own label with an EFUP value less than the product.
Periodic replacement of those consumables or parts to maintain the declared EFUP shall be done
in accordance with the Product Maintenance Procedures.

This product must not be disposed of as unsorted municipal waste, and must be collected sepa-
rately and handled properly after decommissioning.
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有害物质的名称及含量
Name and Concentration of
Hazardous Substances

产品中有害物质的名称及含量
Table of Hazardous Substances’ Name and Concentration

部件名称
Compo-
nent name

有害物质
Hazardous substance

铅
(Pb)

汞
(Hg)

镉
(Cd)

六价铬
(Cr(VI))

多溴联苯
(PBB)

多溴二苯醚
(PBDE)

28930842 X 0 X 0 0 0

28976337 X 0 X 0 0 0

29011360 X 0 0 0 0 0

29011361 X 0 0 0 0 0

29011362 X 0 0 0 0 0

29090689 X 0 0 0 0 0

29090691 X 0 0 0 0 0

29011353 X 0 0 0 0 0

29011358 X 0 0 0 0 0

0: 表示该有害物质在该部件所有均质材料中的含量均在 GB/T 26572 规定的
限量要求以下。

X: 表示该有害物质至少在该部件的某一均质材料中的含量超出 GB/T 26572
规定的限量要求。

• 此表所列数据为发布时所能获得的最佳信息.

0: Indicates that this hazardous substance contained in all of the homogeneous
materials for this part is below the limit requirement in GB/T 26572.

X: Indicates that this hazardous substance contained in at least one of the
homogeneous materials used for this part is above the limit requirement in
GB/T 26572

• Data listed in the table represents best information available at the time of
publication.
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8.5 Ordering information

Introduction
This chapter lists accessories and user replaceable spare parts available for ÄKTA
avant.

Tubing

Item Code no.

Reference capillary 1 28950749

Reference capillary 2 28950750

ETFE Tubing kit 10×1.0 m, id 1.0 mm, od 1/16″

Note:

Outlet tubing for ÄKTA avant 25.

28980995

Tubing kit 10×1.5m, FEP i.d.1.6 mm, o.d. 1/8″

Note:

Inlet tubing for ÄKTA avant 25/Outlet tubing for ÄKTA
avant 150

28980984

Tubing kit 10×1.5m, FEP id 2.9 mm, o.d 3/17″

Note:

Inlet tubing for ÄKTA avant 150.

28980987

Sample tubing kit for 7 inlets i.d. 0.75 mm

Note:

Narrow inlet tubing for ÄKTA avant 25.

28957217

Rinse system tubing 28956504

Replacement tubing kit, ÄKTA avant 25 28956606

Replacement Tubing Kit, ÄKTA avant 150 28979446

BufferPro InA and InB tubing kit, FEP i.d. 1.6 mm o.d. 1/8″ 28980998

Complete tubing marking kit

Note:

Tags for all tubing in ÄKTA avant 25 and ÄKTA avant 150.

28956608

Inlet/outlet tubing tag kit, ÄKTA avant 25

Note:

Tags for all inlet and outlet tubing in ÄKTA avant 25.

28981001
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Item Code no.

Inlet/outlet tubing tag kit, ÄKTA avant 150

Note:

Tags for all inlet and outlet tubing in ÄKTA avant 150.

28981004

Union 1/16″ male/male, i.d. 0.5 mm (5-pack) 28954326

Tubing cutter 18111246

Inlet filter holder kit 11000407

Inlet filter set 11000414

Fittings and connectors

Item Product code

Fingertight connector, 1/16″ male 18111255

Tubing connector for o.d. 1/16″ tubing 18112707

Tubing connector for o.d. 1/8″ tubing 18112117

Tubing connector for o.d. 3/16″ tubing 18111249

Union, 1/16" female to 1/16" female, (5 pcs) 11000339

Union, Fingertight 1/16" female to 1/16" female, i.d. 0.3
mm (4 pcs)

11000852

Union, 1/16" male to M6 female 18111258

Union, 1/16" female to M6 male 18111257

Union, Luer female to 1/16" male 18111251

Union, 1/16" male to 1/16" male, i.d. 0.5 mm (2 pcs) 18112093

Union, 5/16" female to M6 male 18112776

Union, 5/16" female to 1/16" male 18114208

Union, M6 female to 1/16" male 18385801

Ferrule for 1/16" tubing connector, blue 18112706

Ferrule for 1/8" tubing connector, yellow 18112118

Ferrule for 3/16" tubing connector, blue 18111248

Stop plug, 5/16" male 18111250

Stop plug, 1/16" male 18111252
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Holders

Item Code no.

Adapter for air sensor 28956342

Bottle holder 28956327

Column clamp (for columns o.d. 10 to 21 mm) 28956319

Column holder 28956282

Column holder rod 28956270

Flexible column holder 28956295

Loop holder 29011350

Multi-purpose holder 29011349

Rail extension 29011352

Tube holder (5-pack) 28954329

Tubing holder comb 28956286

Tubing holder, spool for small tubing (o.d. 1/8” and
smaller)

28956274

Tubing holder, spool for large inlet tubing (o.d. 3/16”) for
ÄKTA avant 150

29014283

Inlet filter holder kit 11000407

Screw lid kit, GL45 11000410

Conversion kits

Item Code no.

ÄKTA avant Conversion kit, 25 to 150

Note:

Contact Service for installation.

28980168

ÄKTA avant Conversion kit, 150 to 25

Note:

Contact Service for installation.

28981861
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Pump spare parts

Item Code no.

P9-S Seal kit, 65 ml 28960250

P9 Seal kit, 25 ml (seal kit, P9) 28952642

Piston kit, 100 ml (piston kit, P9-S) 18111213

P9 Piston, kit 25 ml 28952640

Check valve kit (check valves in/out for P9, P9H and P9-S) 18112866

P9H Piston kit, 150 ml 28979368

P9H Seal kit, 150 ml 28979373

Mixer

Item Code no.

Mixer chamber 0.6 ml 28956186

Mixer chamber 1.4 ml (mounted at delivery in ÄKTA avant
25)

28956225

Mixer chamber 5 ml (mounted at delivery in ÄKTA avant
150)

28956246

Mixer chamber 15 ml 28980309

O-ring 13.1 × 1.6 mm

Note:

For Mixer chamber 0.6, 1.4, and 5 ml.

28953545

O-ring 13.1 × 1.6 mm High resistance

(can be used as an alternative to 28953545)

29011326

O-ring 22.1 × 1.6 mm

Note:

For Mixer chamber 15 ml.

28981857

Online filter kit 18102711
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Valves

ÄKTA avant 25

Item Code no.

Column Valve V9-C 28956506

pH Valve V9-pH 28956508

Inlet Valve V9-IA 28956510

Inlet Valve V9-IB 28962006

Inlet Valve V9-IS 28962007

Outlet Valve V9-O 28956512

Injection Valve V9-Inj 28956514

Inlet Valve V9-A2 28957221

Inlet Valve V9-B2 28957223

Inlet Valve V9-S2 28957225

Inlet Valve V9-X1 28957227

Inlet Valve V9-X2 28957234

Column Valve V9-C2 28957236

Outlet Valve V9-O2 28957238

Outlet Valve V9-O3 28957240

Versatile Valve V9-V 29011353

Loop Valve V9-L 29011358

ÄKTA avant 150

Item Code no.

Column Valve V9H-C 28979241

pH Valve V9H-pH 28979246

Inlet Valve V9H-IA 28979248

Inlet Valve V9H-IB 28979277

Inlet Valve V9H-IS 28979279

Outlet Valve V9H-O 28979281
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Item Code no.

Injection Valve V9H-Inj 28979283

Inlet Valve V9H-A2 28979303

Inlet Valve V9H-B2 28979315

Inlet Valve V9H-S2 28979320

Inlet Valve V9H-X1 28979326

Inlet Valve V9H-X2 28979328

Column Valve V9H-C2 28979330

Outlet Valve V9H-O2 28979332

Outlet Valve V9H-O3 28979337

Versatile Valve V9H-V 29090691

Loop Valve V9H-L 29090689

Injection valve accessories

Item Code no.

Sample loop, 10 µl 18112039

Sample loop, 100 µl 18111398

Sample loop, 500 µl (mounted at delivery) 18111399

Sample loop, 1 ml 18111401

Sample loop, 2 ml 18111402

Sample loop, FEP 10 ml 18116124

Superloop, M6 fitting, 10 ml 19758501

Superloop, 1/16" fittings (ÄKTA design), 50 ml 18111382

Superloop, M6 fitting, 150 ml 18102385

Fill port, INV-907 18112766

Injection kit, INV-907 18111089

Connector 1/16" Male/Luer Female 28985812
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Built-in fraction collector

Item Code no.

Cassette tray 28954209

Cassette, for 50 ml tubes (2-pack)

Note:

For 6 tubes

28956402

Cassette, for 15 ml tubes (2-pack) 28956404

Cassette for 5 ml tubes (2-pack) 29133422

Cassette, for 8 ml tubes (2-pack) 28956425

Cassette for 3 ml tubes (2-pack) 28956427

Cassette, for deep-well plate (2-pack) 28954212

Rack, for 50 ml tubes

Note:

For 55 tubes

28980319

Rack, for 250 ml bottles 28981873

Fraction Collector F9-R

Item Code no.

Fraction Collector F9-R 29011362

Tube Rack Complete, 175 × 12 mm 19868403

Tube Rack Complete, 95 × 10–18 mm 18305003

Tube Rack Complete, 40 x 30 mm 18112467

Bowl 18305103

Tube Support 18305402

Tubing Holder 18646401

Tube Holder and Guide, 175 × 12 mm 19724202

Tube Holder and Guide, 95 × 10–18 mm 19868902

Tube Holder and Guide, 40 × 30 mm 18112468

Drive sleeve 19606702
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pH monitor

Item Code no.

pH electrode 28954215

O-ring 5.3 × 2.4 mm 28956497

UV monitor

Item Code no.

UV flow cell U9-0.5, 0.5 mm for U9-M 28979386

UV flow cell U9-2, 2 mm for U9-M 28979380

UV flow cell U9-10, 10 mm for U9-M 28956378

UV Monitor U9-L (fixed wavelength) 29011360

UV flow cell 2 mm for U9-L 29011325

UV flow cell 5 mm for U9-L 18112824

Conductivity monitors

Item Code no.

Conductivity Monitor C9 (standard module) 28956495

Conductivity monitor (C9n) (optional) 29011363

External air sensors

Item Code no.

Air Sensor L9-1.2 mm 28956502

Air Sensor L9-1.5 mm 28956500

I/O box

Item Code no.

I/O-box E9 29011361
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Module components

Item Code no.

Module Panel 29011364

Dummy Module 28956493

Extension Box 29110806

Cables

Item Code no.

Jumper 1 IEC 1394 (F-type) 28956489

External module cable, short (F-type) 29012474

External module cable, long (F-type) 29011366

Flow restrictor

Item Code no.

Flow Restrictor FR-902 18112135

Barcode scanner

Item Code no.

Barcode Scanner 2-D with USB 28956452

UniTag

Item Code no.

UniTag (sheet with 108 labels) 28956491

Trays

Item Code no.

Wet side waste tray 28956487

Front side waste tray 28956485
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User Documentation

Item Code no.

ÄKTA avant User Manual

Note:

Covers ÄKTA avant 25 and ÄKTA avant 150.

29035184
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8.6 Health and Safety Declaration Form

On site service

 

 

On Site Service Health & 
Safety Declaration Form 

 
 

Service Ticket #: 
 

 

To make the mutual protection and safety of Cytiva service personnel and our customers, all equipment and work areas must be 
clean and free of any hazardous contaminants before a Service Engineer starts a repair. To avoid delays in the servicing of your 
equipment, complete this checklist and present it to the Service Engineer upon arrival. Equipment and/or work areas  
not sufficiently cleaned, accessible and safe for an engineer may lead to delays in servicing the equipment and could be subject to 
additional charges. 
 

 Yes  No 
Review the actions below and answer “Yes” or “No”.  
Provide explanation for any “No” answers in box below. 

 

 

 

 

 

 

Instrument has been cleaned of hazardous substances. 
Rinse tubing or piping, wipe down scanner surfaces, or otherwise make sure removal of any dangerous residue. 
Make sure the area around the instrument is clean. If radioactivity has been used, perform a wipe test or other 
suitable survey. 

 

 

 

 

Adequate space and clearance is provided to allow safe access for instrument service, repair or 
installation. In some cases this may require customer to move equipment from normal operating location 
prior to Cytiva arrival. 

 

 

 

 
Consumables, such as columns or gels, have been removed or isolated from the instrument and from 
any area that may impede access to the instrument . 

  All buffer / waste vessels are labeled.  
Excess containers have been removed from the area to provide access. 

Provide 
explanation 
for any “No” 
answers here: 

 

Equipment type / Product No:  Serial No:  

I hereby confirm that the equipment specified above has been cleaned to remove any hazardous substances and that the area 
has been made safe and accessible. 

Name:  Company or institution:    

Position or 
job title: 

 Date (YYYY/MM/DD):  

Signed: 
 

Cytiva and the Drop logo are trademarks of Global Life Sciences IP Holdco LLC or an affiliate. 

© 2020 Cytiva. 
All goods and services are sold subject to the terms and conditions of sale of the supplying company operating 
within the Cytiva business. A copy of those terms and conditions is available on request. Contact your local Cytiva 
representative for the most current information. 

For local office contact information, visit cytiva.com/contact. 
28980026 AD 04/2020 
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Product return or servicing

 

Health & Safety Declaration Form 
for Product Return or Servicing 

 
 

Return authorization 
number: 

 and/or 
Service Ticket/Request: 

 

To make sure the mutual protection and safety of Cytiva personnel, our customers, transportation personnel and our environment, 

all equipment must be clean and free of any hazardous contaminants before shipping to Cytiva. To avoid delays in the processing of 

your equipment, complete this checklist and include it with your return. 

1. Note that items will NOT be accepted for servicing or return without this form 

2. Equipment which is not sufficiently cleaned prior to return to Cytiva may lead to delays in servicing the equipment and 

could be subject to additional charges 

3. Visible contamination will be assumed hazardous and additional cleaning and decontamination charges will be applied 

 Yes   No Specify if the equipment has been in contact with any of the following: 

  Radioactivity (specify)  

  Infectious or hazardous biological substances (specify)  

  Other Hazardous Chemicals (specify)  

Equipment must be decontaminated prior to service / return. Provide a telephone number where Cytiva can contact 
you for additional information concerning the system / equipment. 

Telephone No:   

Liquid and/or gas in equipment is:  Water 

 Ethanol 

 None, empty 

 Argon, Helium, Nitrogen 

 Liquid Nitrogen 

Other, specify  

Equipment type / Product No:  Serial No:  

I hereby confirm that the equipment specified above has been cleaned to remove any hazardous substances and that 
the area has been made safe and accessible. 

Name: 
 Company or 

institution:   
 

Position or job title:  Date (YYYY/MM/DD)  

Signed:   

Cytiva and the Drop logo are trademarks of Global Life Sciences IP Holdco LLC or an affiliate. 

© 2020 Cytiva. 
All goods and services are sold subject to the terms and conditions of sale of the supplying company operating 
within the Cytiva business. A copy of those terms and conditions is available on request. Contact your local Cytiva 
representative for the most current information. 

For local office contact information, visit cytiva.com/contact. 
28980027 AD 04/2020 

To receive a return authorization number 
or service number, call local 
technical support or customer service.  
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D
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UniTag, 179
UV monitor, 176, 178
valves, 175

Outlet tubing, 93
prepare, 93

P

Personal protection, 13, 14
pH monitor, 125

storage of the pH electrode,
125

Power requirements, 48
Prepare the system, 67, 103

ÄKTA avant, 103
Start UNICORN, 67

Pressure alarm, 99
set, 99

Prime inlet tubing B, 70
Prime sample inlets, 77
Process picture, 122
Product return or servicing, 182
Pumps, 70, 130, 139, 147, 148

clean check valves, 148
purge system pumps, 70
replace pump piston seals of
Pump P9 or P9H, 130
replace pump piston seals of
Pump P9-S, 139
replace pump pistons, 147

Purpose of this manual, 5

R

Recycling information, 161
decontamination, 161

Reference information, 153, 155
chemical resistance guide,
155
system specifications, 153

Regulatory information, 162
Requirements, 47, 48

environment, 47
power, 48

Room requirements, 44
introduction, 44

Run, 116, 122, 124
after run procedures, 124
monitor a run, 122
start, 116

S

Safety notices, 7
Safety precautions, 11, 12, 15, 21,
23, 42, 45

emergency procedures, 23
general precautions, 12
installing and moving the
instrument, 15, 42
introduction, 11
labels, 21
system operation, 45

Site environment, 47
Software overview, 37

software modules, 37
Storage, 124, 125

column, 125
pH electrode, 125
system, 124

System Control module, 38, 122
description, 38
icons, 38
process picture, 122

System preparation, 88
before preparation, 88

System recommendations, 49
computer specifications, 49

System storage, 124

T

Technical specifications, 153
system specifications, 153

Typographical conventions, 5

U

UNICORN, 37, 38, 67, 68
connect to system, 68
Log on, 67
Start, 67
System Control module, 38

User information, 6
important, 6
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Waste tubing, 58, 93
prepare, 58, 93
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Cytiva and the Drop logo are trademarks of Global Life Sciences IP Holdco LLC or an affiliate.

ÄKTA, Superloop, and UNICORN are trademarks of Global Life Sciences Solutions USA LLC or an affiliate doing business as Cytiva.

BD is a trademark of Beckton, Dickinson and Company, Decon is a trademark of Decon Laboratories Ltd., Eppendorf is a trademark of
Eppendorf AG, Kautex is a trademark of Kautex Textron GmbH & Co KG, Microsoft and Windows are registered trademarks of
Microsoft Corporation, Nalgene, Nunc, and Thermo Scientific are trademarks of Thermo Fisher Scientific or its subsidiaries, Tween is a
trademark of Croda Group of Companies, VWR is a trademark of VWR International, Inc..

All other third-party trademarks are the property of their respective owners.

© 2020 Cytiva

Any use of UNICORN is subject to Cytiva Standard Software End-User License Agreement for Life Sciences Software Products. A copy
of this Standard Software End-User License Agreement is available on request.

All goods and services are sold subject to the terms and conditions of sale of the supplying company operating within the Cytiva
business. A copy of those terms and conditions is available on request. Contact your local Cytiva representative for the most current
information.

For local office contact information, visit cytiva.com/contact

29101556 AC V:6 09/2020
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